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INTRODUCTION 
 

The use of advanced information technologies is key to successful 

calculations at the design stage of new buildings and structures, as well as 

when assessing the bearing capacity of existing ones. Currently, there are 

numerous automated software packages. The results obtained with their 

help allow for significantly improving the quality and speed of solving 

relevant engineering problems. 

The adoption of technically sound and supported by appropriate 

calculations of structural solutions is the most important stage of design. 

Therefore, it is of great importance for higher education students to master 

modern automated design tools for calculating the strength, stability, rigidity, 

and design of building structure elements. 

The course "CAD in Construction" of the educational and 

professional program "Construction and Civil Engineering" of the field of 

knowledge 19 Architecture and Construction, specialty 192 Construction 

and Civil Engineering teaches the basics of practical work with the design 

and computing complexes LIRA-SAPR and MONOMAKH-SAPR. This 

methodological development is intended to assist higher education students 

in completing laboratory tasks from this course and contains algorithms for 

calculating and designing reinforced concrete and metal structures in the 

environment of the LIRA-SAPR and MONOMAKH-SAPR PCs. 
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Course Objectives   
 
The purpose of teaching the academic discipline "CAD in 

Construction" is to prepare higher education applicants for professional 

activity in the field of construction design in the conditions of modern 

information technologies. 

The objectives of the course are for students to acquire the 

necessary knowledge about modern computer-aided design (CAD) systems 

in construction and to obtain practical skills in design work on the 

calculation and design of building structures, buildings, and structures in the 

environment of design and computing complexes LIRA-SAPR and 

MONOMAKH-SAPR. 

After completing the course, the student must know: 

- principles of designing elements of building structures; 

- methods of selecting and checking reinforcement of reinforced 

concrete elements; 

- basic provisions of calculating and designing steel structures. 

The student must be able to: 

- perform design work in the construction industry using design and 

computing complexes LIRA-SAPR and MONOMAKH-SAPR; 

- calculate, design, investigate construction objects; 

- use the necessary computer software products in work; 

- apply the basic principles, theories and methods of structural 

mechanics to calculate elements of buildings and structures under the 

action of loads and influences of various nature, taking into account their 

interaction, using automated design systems; 

- calculate and design reinforced concrete (monolithic and 

prefabricated), metal and wooden structures using the requirements of 

regulatory documents, providing reliable and economically justified design 

solutions; 

- Calculate and design load-bearing structures of reinforced concrete, 

metal, and wooden structures, including using modern information 

technologies. 
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Content Module 1 

  

Computer-aided implementation of the calculation and design of 

structures of buildings in the LIRA-FEM 

 

Topic 1. Introduction to the LIRA- FEM 

 

Laboratory Work No. 1 

 

LIRA- FEM ribbon interface. 

General algorithm for calculating structures 
 

Purpose and plan of the session 
 
To get acquainted with the ribbon interface and the capabilities of the 

software package. To get acquainted with the general algorithm for 
calculating structures 

 

The ribbon interface of the LIRA- FEM 

 

The ribbon interface of the LIRA-FEM contains the following main 
components: tabs, contextual tabs, panels, and menus. 

A tab is an element of the graphical user interface that allows you to 
switch between certain sets of interface elements in one window. 

 

Fig. 1 – Ribbon tabs and panels 

 

Contextual tabs (Nodes, Bars, Plates) appear when nodes and 
elements are selected and disappear after they are deselected (Figs. 2, 3, 
4). 

The Quick Access Toolbar (Figure 6) is located at the top of the 
ribbon and provides direct access to a specific set of commands. The bar is 
customizable and contains a set of commands that are independent of the 
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tab currently displayed on the ribbon. 

 

Fig. 2 – Quick Access Toolbar 

Program menu (Fig. 3)—a menu for working with document files 
and setting units of measurement, interface language, and parameters for 
graphical display of the scheme and calculation results. This command is 

called by clicking on the button . The main page of the menu (on the 
right) displays a list of documents that were opened recently (Fig. 3). 

The program menu contains operations that provide work with files 
used by VIZOR-SAPR. To manage the task as a whole, commands 
collected in the program menu are used. The menu consists of two panels: 
the left one displays groups of commands for working with files, and the 
right one displays a list of commands in the selected group. 

 

Thus, the New group (Fig. 4)—a group of commands for creating a 
new problem file—contains commands for specifying the schematic 
characteristics: 

 
• the first schema characteristic—two degrees of freedom in the node 

(displacement X, Z) XOZ; 
• the second schema characteristic—three degrees of freedom in the 

node (displacement X, Z, Uy) XOZ; 
• the third schema characteristic—three degrees of freedom in the 

node (displacement Z, Ux, Uy) XOY; 
• the fourth schema characteristic—three degrees of freedom in the 

node (displacement X, Y, Z); 
• the fifth schema characteristic—six degrees of freedom in the node 

(displacement X, Y, Z, Ux, Uy, Uz). 
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Fig. 3 – Expanded Program Menu 
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Fig. 4 – Expanded program menu, New command group 

Another important group of commands – Settings (Fig. 5) – allows 

you to change the program settings (units of measurement, scale 

parameters, colors, calculation parameters, number and font formats, and 

interface language). 
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Fig. 5. Expanded program menu, Settings command group 
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Status bar (Fig. 6)—a panel at the bottom of the window, designed 
to display tips for menu items and display elements, and also contains 
blocks for loading the calculation scheme and loading the analysis (in the 
results analysis tabs) and a block for construction. 

 

Fig. 6 – Status bar 

On the Create and Edit tab (Fig. 7), operations are performed to 
create and basic edit the geometry of the scheme, assign stiffness 
characteristics, and generate loads. 

 

 
 

Fig. 7, a – Creation and Editing Tab 
 

 
 

Fig. 7,b – Creation and Editing Tab (continued) 
 

The Create and Edit tab contains the following panels: 
• Create – here you select typical operations for creating the 
geometry of the scheme and triangulating the contours; 
• Edit – operations for basic editing of the scheme (copying, moving, 
scaling), packing the scheme, and editing the triangulation mesh; 
• Stiffnesses and ties – operations for assigning stiffnesses and 
materials to the scheme elements, modeling fasteners, etc.; 
• Design – operations for creating design options and assigning 
materials to them, working with structural blocks, creating structural 
or unified elements for further calculation of reinforcement; 
• Loads – operations for forming loads and assigning loads to nodes 
and scheme elements; 
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• Tools – operations for configuring the graphical display of results 
and output data of the scheme. 

On the Advanced Edit tab (Fig. 8), you can perform operations for 
advanced editing of the scheme, assembling the scheme from 
subschemes, working with blocks and superelements, and connecting to 

the soil foundation scheme. The Tables panel contains commands that 
allow you to create, layout, and print a table, report, or explanatory note that 
is needed to document the current task. 
 

 
Fig. 8 – Advanced Editing Tab 

 

On the Analysis tab (Fig. 9), operations are performed to specify 
data for static, dynamic, and additional calculations; generate tables; control 
parameters for calculation; and launch a calculation task. 
 

 
Fig. 9 – Analysis Tab 

 

The Analysis tab contains the following panels: 
• Calculation – operations to change calculation parameters for the 

current problem, load data to the calculation processor, and perform the 
calculation; 

• Dynamics – operations to organize the calculation for dynamic 
effects, specify the characteristics of each specific dynamic effect; 

• DCF – operations to form calculation combinations of forces; 
• Add calculations – specification of initial data for calculating 

displacements in nodes and forces (stresses) in elements from standard 
and arbitrary linear combinations of loads, for calculating loads on a 
fragment, for calculating principal and equivalent stresses in finite elements, 
for calculating stability; 

• Nonlinearity – specification of parameters that determine the 
specificity and organization of the step process for solving nonlinear 
problems; 

• Installation – specifying information for computer modeling of the 
construction process, which involves the installation and/or dismantling of 
elements, changing the conditions for securing the structure or connecting 
elements to each other.  

The Results tab (Fig. 10) contains the most frequently used results 
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analysis functions: displaying numerical and graphical information on the 
movement of nodes, forces and stresses in the elements of the design 
scheme. 

 

 
Fig. 10 – Results Tab 

 

The Results tab contains the following panels: 
 

 Deformations (Fig. 11)—operations that allow you to display 
deformations of a structure. 

 

 
Fig. 11 – Deformation Panel 

 

 Forces in rods (Fig. 12) – operations for displaying diagrams and 
mosaics of forces in rods. 

 
 
 
 
 

Fig. 12 – Forces in Bars 
 

 Stresses in plates and 
volumetric SEs (Fig. 13) – operations for coloring plates and 
surfaces of volumetric elements according to the values of stresses 
in them. 

 
 
 
 
Fig. 13 – Panel Stress in 
plates and Solids 
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• Tools (Fig. 14) – the main tools for configuring the graphical display 
mode of the scheme and the functions for presenting the results. 

 

   Fig. 14 – Tools Panel 
 

• Tables (Fig. 15) – displaying a numerical representation of results 
and launching modes for generating a report and explanatory note. 

 

 Fig.  15 – Tables Panel 
 

 

 

Documentation drop-down list (Fig. 16) 
– the drop-down list contains operations 
for generating documentation for the 
current task, tables based on the results 
of static/dynamic calculations, creating 
and arranging drawings with various 
fixed variants of the calculation scheme 
and calculation results, generating a 
report or explanatory note. 

Fig. 16 – Documentation – drop-down list 
 

The Design tab (Fig. 17) contains operations for specifying initial 
data for design, calculating reinforcement of reinforced concrete elements, 
checking and selecting steel sections, displaying numerical and graphical 
information on the results of design system calculations, and launching 
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local modes. 
 

 
Fig. 17, а – Design Panel 

 

 
Fig. 17, b –  Design Panel (continued) 

 

The Design tab contains the following panels: 

 Calculation – operations related to the calculation of reinforcement. 

 Fig. 18 – Calculation Panel 
 
• Plate reinforcement – operations for displaying the results of plate 
element reinforcement. 

  
Fig. 19 – Plate Reinforcement Panel 
 
• Bar Reinforcement – operations for displaying the results of bar 
element reinforcement, beam and column design. 

  
Fig. 20 – Bar Reinforcement Panel 
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• Tools – operations for managing the color settings of isofields and 
mosaics of the initial data of the calculation scheme, the results of 
static/dynamic calculations, the results of checking and selecting 
steel sections, the results of determining areas and selecting 
reinforcement, operations for configuring the scale update and color 
display of nodes/elements of the scheme on the screen, as well as 
the ability to open the scheme in SAPFIR, etc. 
 

 Fig. 21 – Tools Panel 
 

 Design – operations for changing stiffnesses and specifying initial 
data for design. 
 

  
Fig. 22 – Design Panel 
 

Steel: calculation – operations for calculating 
steel elements.  

 
 
 
 

Fig. 23 – Analysis Panel 
 

 Tables – operations for displaying numerical representation of 
results on the screen, as well as launching modes for generating a report 
and explanatory note. 
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Fig. 24 – Tables Panel 
 

 

General algorithm for calculating structures in the LIRA-FEM 

 
1. Creating a file (the name must contain up to 30 characters), selecting the 
design scheme feature, comments. 
2. Setting up the program (units of measurement, interface language, main 
panels). 
3. Selecting the cross-section calculation option (based on efforts from 
individual loads, RSZ or RSN). Selecting the design option: 
• for reinforced concrete structures – according to DBN V.2.6-98:2009. 
Structures of buildings and structures. Concrete and reinforced concrete 
structures. Basic provisions; 
• for MK – according to DBN V.2.6-198:2014. Steel structures. Design 
standards. 
4. Creating a geometric diagram of the structure. 
5. Setting boundary conditions. 
6. Creating and assigning stiffnesses. 
7. Visual 3D control. 
8. Specifying loads. 
9. Static calculation of the structure. 
10. Analysis of the results of the static calculation. 
11. Purpose of materials: 
• for reinforced concrete – type, concrete, reinforcement; 
• for reinforced concrete – material, additional characteristics, selection 
restrictions. 
12. Full calculation (static and structural). 
13. Review and analysis of the results: 
• for reinforced concrete – selection of reinforcement, 
• for reinforced concrete – checking and selection of sections. 
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Topic 2: Calculation and design of a reinforced concrete beam 

 

Laboratory Work No. 2 
 

Creating a calculation model of a beam 

Task. Perform the calculation of a reinforced concrete beam with a 
rectangular cross-section measuring 30x60 cm, a span of 6 m, made of 
concrete of class C25/30, reinforced with longitudinal reinforcement of class 
A400C, loaded with a uniformly distributed load along the length with an 
intensity of q=30kN/m. Analyze the results of the static calculation. 

 
Purpose and plan of the session 

Create a new project. Configure the program. Specify the calculation 
and design option. Create a geometric diagram. Specify boundary 
conditions. Specify stiffness characteristics. Specify the load. Perform the 
calculation. 

Creating a new project 

To start working with LIRA-SAPR, 

execute the Windows command: Start  

  Programs    LIRA-FEM 2024. 

To create a new file, open the 

Programs Menu , select the New 

item, then – The second feature of 

the scheme (Fig. 25) – three degrees 
of freedom in the node (displacement 
X, Z, Uy), the XOZ plane. 

In the Diagram Description dialog box 
(Fig. 26), specify the file name and, if 
desired, a comment (for example, the 
date the diagram was created).  
 

 
Fig.25 – Programs menu, selecting a 

scheme feature 
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Fig. 26 – Dialog box Description of the scheme 

Program settings 

To set the units of measurement, you need to go to the Programs 

menu , select Settings – Units of measurement from the drop-down 
list. In the dialog box of the same name, set the necessary units: on the 
Scheme tab – loads and material parameters – kN, on the Results tab 
(stress – kPa, force – kN) – Fig. 27.  

   

Fig. 27 – Units dialog box 
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 In order not to clutter up the 
workspace with unnecessary panels, it 
is advisable to display the three most 
important ones on the screen using 
the right mouse button: Selection 
Panel, Projection Panel and Errors 
and Warnings. 

Selecting a calculation and design 

option 
For structural calculations according 
to current standards, you need to click 

the button – Design options and 
in the Design options dialog box, 
select the required standard (DBN 
V.2.6-98:2009) – Fig. 28. In the same 
window, specify the calculation option 
(by individual efforts or design 
combinations of loads – DCL (or 
forces – DCF). 
 
 
 
 
Fig. 28. Design options dialog box  

 

 

 

Creating a geometric diagram of the structure 

To create a geometric diagram of a beam, you need to call the 

Create flat fragments and meshes dialog box, on the Frame generation 
tab, specify six elements with a length of 1 m along the first axis (along X) 
(Fig. 29). 

As a result, a geometric diagram of the beam will be constructed (Fig. 30). 
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Fig. 29 – Dialog box Creating flat fragments and meshes 

 

Fig. 30 – Created geometric diagram of the beam 
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Setting boundary conditions 

The node numbers on the calculation diagram are displayed on the 
screen. 

       

 

To display node or element numbers, 
you need to use the command button 

 – Flags of Drowing, which calls 

the Display dialog box (Fig. 31), where 
you need to check the corresponding 
boxes on the Elements and Nodes 
tabs. In this case, it is worth activating 
the Apply automatically option. 

 

 
 
 
 
Fig. 31 – Display dialog box (Elements 
and Nodes tabs) 

Activate the command button  – Mark nodes, mark node №1 (it 

will be displayed in red). To specify the nodes, use the button . In the 

Nodes dialog box, mark the directions in which node №1 is prohibited from 

moving (Z – hinged-movable support), click  – Add nodes in marked 

nodes. Then mark node №7. In the Nodes dialog box, mark the directions 

X, Z (hinged-fixed support) and click . 
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Creating and assigning stiffnesses 

Click the button  – Element stiffnesses and materials. In the 

Stiffnesses and Materials dialog box (Fig. 32), create a list of stiffness 

types. On the Stiffnesses tab, click the Add button, select the Standard 

cross-section types tab, and activate the Beam cross-section. 

 

 
 

Fig. 32 – Stiffness and Materials dialog box 
 
 

In the Specify Standard Section dialog box (Fig. 33), enter: 

- modulus of elasticity for concrete of class C25/30  

– E = 32500000 kN/m² (or 3.25e+007 – written in exponential form, 

with English keyboard layout); 

- geometric dimensions – B = 30 cm; H = 60 cm; 

- material density – Ro = 25 kN/m². 
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To display a sketch of the created section, click the Draw button, then 

confirm . After that, assign the specified stiffness to the beam 

elements. 

 

Fig. 33 – Define standard section Dialog box 

 

Setting a load 

On the Loads panel, select the Load command, and from the drop-

down list, select Load on a member (Fig. 34). 
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Fig. 34 – Command Load on a rod in the drop-down list 
 
 

The Load specification dialog box will appear (Fig. 35), in which the 

radio buttons indicate the Global coordinate system, the direction of the 

load action – along the Z axis. By clicking on the uniformly distributed load 

button , the Parameters dialog box will be called. In this window, 

you need to enter the load intensity P = 30 kN/m (Fig. 35) and click the 

button  – Confirm. 
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Fig. 35 – Dialog boxes for specifying loads 

 

Using the button  – Mark elements, mark all the elements of the 

beam. In the dialog box Load definition, also click the button – Confirm. 
A linear load of 30 kN/m evenly distributed over the entire length will 

be applied to the beam (Fig. 36). 
 

 
Fig. 36 – Applied load 

 
To specify information about the load, you must use the button 
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 – Edit Load cases on the Loads panel, Create and edit tab. The 

Load Editor dialog box will appear (Fig. 37), in which for load 1 in the Edit 

selected load field, you must select the Constant ribbon from the View list 

and click the button . 
 

 
 

Fig. 37 – Load Editor dialog box 



 

29 

 

 
You can specify advanced load information before generating the load. 

Full beam calculation. 
Before starting the calculation, it is recommended to save the created 

calculation scheme. To do this, use the   – Save button on the quick 

access panel. In the Save As dialog box, give the file a name and select a 

folder for saving. To calculate, click the – Perform calculation button 

on the Analysis tab. 

 

Laboratory Work No. 3 

Analysis of static calculation results and beam design 
 

Purpose and plan of the session 

Review and analyze the results of the static calculation of the beam. 
Display the force diagrams in the beam elements on the screen. Create 
tables of calculation results. 

Assign material parameters for structural calculation. Analyze the 
results of reinforcement selection in the beam elements. Display the results 
on the screen in the form of a mosaic and reinforcement diagrams. Design 
the beam. 

 Viewing and analyzing static calculation results 

To switch to the static calculation results visualization mode, go to the 

Results tab. In the calculation results viewing mode, the calculation 
diagram is displayed by default, taking into account the displacements of 

the nodes (Fig. 38). To display the initial diagram, click the button  

(Deformations panel on the Results tab). 

 

Fig. 38. Calculation diagram taking into account the displacement of nodes 

 

To view the force diagrams, use the command buttons   (Force 

in Members panel on the Results tab) – Fig. 39. The force diagrams are 
shown in Figs. 40 and 41. 
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  Fig. 39. Forces in Bars panel 

 

Fig. 40 –  Bending moment diagram 

 

Fig. 41 – Diagram of transverse forces 

 

To generate and view tables of calculation results, select the 

Standard Tables command in the Documentation drop-down list (Tables 

panel on the Analysis tab) – Fig. 42.  

 

 

Fig. 42 – Standard Tables command 
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In the Standard Tables dialog box, select the Efforts tab (Fig. 43) 

and click the button .   

 

Fig. 43 – Tables dialog box 

 

The program will generate tables with the results of static beam 
calculations – moments and shear forces in the elements of the calculation 
scheme (Fig. 44). 

 

Fig. 44 – Table of forces in beam elements 
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Setting material parameters for structural calculation 
 

On the Reinforced Concrete (RC) tab in the Stiffness and Materials 
dialog box, you need to set the parameters for designing reinforced 
concrete structures: type, concrete, reinforcement (Fig. 45). To do this, 
select the Type radio button and click the Edit button. 

 

 
 

Fig. 45 – Stiffness and Materials dialog box, Reinforced Concrete tab 
 



 

33 

 

The Materials for Calculating Reinforced Concrete Structures 
dialog box will appear (Fig. 46), in which you should left-click in the Bar 
field. In the upper right corner, specify: calculation type – Beam, 
reinforcement – Asymmetric, system – Statically determinate, uncheck the 
Select corner bars command (for beams, use the discrete reinforcement 
algorithm). In the Concrete field, select concrete class C25/30. In the 
Reinforcement field, specify: longitudinal – class A400C, transverse – 

A240C. To save the entered data, click the   – Confirm button. 
 

 
Fig. 46 – Materials dialog box for calculating reinforced concrete 

structures 
 

Use the   button to select all beam elements. The elements are 

highlighted in red. In the Stiffness and Materials dialog box, click the   

button  to confirm. Close the Stiffness and Materials dialog box. To 

view the assigned stiffnesses, click the  button to open the Display 
dialog box, and on the Elements tab, select the Stiffness Types check box. 
The program will display the assigned stiffness type (1) for each finite 
element (FE).  
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Reviewing and analyzing the results of beam reinforcement 
 

On the RC tab, click the  – Reinforcement Calculation button 
and review and analyze the reinforcement results. To do this, select the 

Asymmetry command on the Bar Reinforcement panel to set the display 
mode for asymmetric reinforcement (Fig. 47). 

 

 
Fig. 47 –  RC tab 

 

 
Fig. 48 – Asymmetric reinforcement command 

 
The program displays the selected reinforcement either in a color 

corresponding to the scale (on the scale, this reinforcement is presented as 

the area of reinforcement in cm2) or in the form of a reinforcement diagram. 

The user selects the desired display mode – in the first case, select the 

Reinforcement mosaic in bars command, in the second case – 

Reinforcement diagrams in bars (Fig. 50). To display the reinforcement at 

the bottom edge of the beam, press the button  – Distributed 

reinforcement AU1. 
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Fig. 49 – Reinforcement display modes 

 
Fig. 50 – Diagram of selected reinforcement in beam elements 
(longitudinal reinforcement AU1 near the bottom edge) 

 
To view information about the selected 

reinforcement in one of the SEs, click the   – 

Information about the node or element button on 

the Selection Panel toolbar and point the cursor 

at the desired beam element (currently No. 4). In 

the dialog box that appears (Fig. 51), go to the 

Longitudinal reinforcement tab (this window 

contains complete information about the selected 

element, including the results of reinforcement 

selection).  

According to the calculation results, the area of 

longitudinal reinforcement in the lower (tension) 

zone of the beam is 702 mm2. The required 

number of rods is selected according to the 

assortment—for example, 214+216 class 

A400C (the actual cross-sectional area will be: 

307.7+401.9=709.6 mm2). 

 
Fig. 51 – Element Information dialog box 
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Topic 3. Calculation and design of reinforced concrete slabs 

Task. Calculate a monolithic reinforced concrete flat slab with 

dimensions BxL=36 m and thickness h=160 mm. The slab is freely 
supported by its shorter sides on the walls. Perform the calculation for a 
6х12 grid under the following loads: 

 load 1 – dead weight of the slab; 
 load 2 – quasi-permanent, evenly distributed over the entire 

area of the slab p2 = 0.35 kPa; 
 load 3 – short-term, evenly distributed over the entire area of 

the slab p3 = 1.15 kPa. 

 

Laboratory Work No. 4 

Creating a calculation model of a slab, static calculation 
 

Purpose and plan of the session 

Create a new task. Create a geometric diagram of the slab. Set 
boundary conditions and calculation options. Simulate two loads and set 
detailed information about them. Generate a table of calculated load 
combinations (DCL). Perform a complete calculation of the model. 

Creating a file    

     

 To create a new file, click 
the   New  button on the 
Quick Access Toolbar. In 
the Diagram Description 
dialog box, specify the 
Diagram Type – 3 – three 
degrees of freedom in the 
node (Z, Ux, Uy 
displacement) XOY,  the file 
name, and, if desired, a 
comment (Fig. 52). Click the 

  – Confirm button. 

Fig. 52 – Model type dialog box 
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Creating a geometric diagram of the slab 

  

On the Creation and Editing tab, 

click the   - Generation of Flat 
Fragments and Grids button to open 
a drop-down list, where you can 
select the Slab Generation command. 

 

 

Fig. 53 – Calling the Slab Generation 
command 

  The Create Flat Fragments and 

Grids dialog box will appear. In the 
table, set the step along the first axis 
to 0.5 m and the number of steps to 
6; along the second axis, set the 
step to 0.5 and the number of steps 
to 12 (Fig. 54). Leave the rest of the 
parameters as default and click the 

Confirm button . 

To save the information about 

the created model, click the    
button on the quick access toolbar. 

 

Fig. 54 – Create Flat 
Fragments and Meshes dialog box. 

 

Setting boundary conditions 

To set boundary conditions, display the node numbers on the 
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calculation diagram by activating the command button  – Node Marking, 
select the nodes supporting the slab along two short edges with the cursor 
– Nos. 1-7 and 85-91 (they will be displayed in red). To set boundary 

conditions at the support nodes, open the dialog box  Connections at 

nodes by clicking the button  – Connections (Stiffness and 

Connections panel on the Create and Edit tab).  

In the dialog box, select the directions in which node movement is 

prohibited (Z – hinged support). To execute the command, click the   – 
Add restraints at selected nodes button. The color of the nodes will change 
from red to blue, indicating that the command has been executed (Fig. 55). 

 

Fig. 55 – Setting constraints in the support nodes of the slab 

 

Setting calculation and design options  
 

For design calculations, click the  button – Design Options 

(Design panel on the Create and Edit tab). In the Design Options dialog 
box, specify the parameters for the first option  design (selection of 
reinforcement according to Karpenko's theory) – Fig. 56. In the same 
window, select the calculation option (according to the design combinations 

of forces - DCF) and the applicable standards. Click the Apply button. 
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To create the second design option 

(selection of reinforcement according to 

Wood's theory), click the button  - 

Create a new design option. Then 

specify the following parameters: 

design option name – Option 2; 

standards for reinforced concrete and 

steel calculations; type of cross-section 

calculation – according to RC. Enter the 

data for the design option by clicking 

the  - Apply button. 

 

 

 

 

 

 

Fig. 56 – Design Options dialog box 

 

 

Double-clicking on the Design Options List ribbon activates the 

selected option in the graphical environment. Select the Option 1 ribbon and 

click the Set as Current button. Close the Design Options window by 

clicking the Close button . 

The materials for the design option are selected in the Stiffness and 

Materials dialog box (Fig. 57). 
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Fig. 57 – Stiffness and Materials dialog boxes, Add Stiffness 
 

Creating and assigning stiffnesses 

and material parameters 
        
To set the stiffness type, click the button 

 to open the Stiffness and Materials 

dialog box (Stiffness and Joints panel on 

the Create and Edit tab). On the Stiffness 
tab, click the Add button. In the Add 

Stiffness dialog box, select the third tab – 
Plate, Volume, Numerical – and activate the 
Plate cross-section.  

In the Set Stiffness for Plates dialog 
box (Fig. 58), enter: 
the modulus of elasticity for C25/30 concrete 
– E=3.25e7 kN/m2; 
- Poisson's ratio – V=0.2; 
- thickness H = 16 cm; 
- material density - Ro = 25 kN/m3. 

 
Fig. 58 – Stiffnesses for plates Dialog box  
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 To close the stiffness 
characteristics library, click the 

Close button  in the Add 

Stiffness dialog box or the Add 

button in the Stiffness and 

Materials window.  
On the Reinforced Concrete 

(RC) tab of the Stiffness and 

Materials dialog box, you need 
to set the parameters for 
reinforced concrete structures: 
type, concrete, reinforcement 
(Fig. 59). 
 
 
 
 
 
 
 
 
Fig. 59 –  Stiffness and 
Materials dialog box, 
Reinforced Concrete tab 

 
 

Select the Type radio button and click Edit. 

The Materials for reinforced concrete structures calculation dialog 
box appears (Fig. 60), in which you left-click in the Plate field. In the upper 
right corner, specify: calculation type – Slab (bending), reinforcement bar 
spacing – 200 mm. In the Concrete field, select concrete class C25/30, in 
the Reinforcement field: longitudinal – class A400C, transverse – A240C. 

To save the entered data, click the   – Confirm button . 

Using the  – Mark elements button, mark all elements of the slab, 
and the elements will be highlighted in red. In the Stiffness and Materials 

dialog box, click the  – Confirm button. Close the Stiffness and 

Materials dialog box. To view the assigned stiffnesses, click the  

button to open the Display dialog box, and on the Elements tab, select the 
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Stiffness Types check box. The program will display the assigned stiffness 
type (1) for each FE (finite element). 

 

 
Fig. 60 – Materials dialog box for calculating reinforced concrete 

structures 
 
To specify materials for the second option of reinforced concrete 

structures design, in the Stiffness and Materials dialog box (Fig. 59), use 

the counter to switch to option No. 2. Then select the Type radio button and 

click the Edit button. The Materials for reinforced concrete structures 
calculation dialog box (Fig. 60) appears on the screen, in which you specify 
the following parameters for plate elements: 

•    In the Plate field 
- In the Calculation type line, select Plate (bending); 
- Select the Select reinforcement according to Wood's theory 

checkbox; 

•    In the Concrete characteristics field 
- In the Concrete class line, select C25/30; 
- in the Stress-strain diagram line - 2-linear; 

• in the Reinforcement characteristics field 
- in the Classes field - longitudinal - A400C, transverse - A240C; 
- in the Reinforcement cage type field – knitted; 
- maximum diameter – 25 mm; 
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- leave the rest of the parameters as default. 

After that, click on the button   – Confirm. 

To assign stiffnesses and materials to slab elements, click on the 

button   – Mark elements on the Selection Panel toolbar. At the same 

time, the stiffness – 1 should be set in the list of the current stiffness type. 

Plate H 16, and in the list of current materials – Type 2. Slab (bending), 

Concrete – 1. C25/30, Reinforcement – 1. A400C. Use the cursor to select 

all elements of the diagram by stretching the “rubber window” around the 

group of elements. In the Stiffness and Materials dialog box, click the 

Apply button . The color of the elements will change from red to blue, 

which means that the elements have been assigned the current stiffness. 

To switch to the first design option, in the Stiffness and Materials 

dialog box, use the Current Design Option Number counter to select 

design option 1. To assign materials to the first design option, clear the 

Stiffness check box in the Assign to Scheme Elements field. In the 

Stiffness and Materials dialog box, select line 1 in the list of general 

properties of materials for reinforced concrete elements with the cursor. 

Plate (bending), click the Assign as Current button. Select all elements of 

the diagram with the cursor and click the Apply button . 

Loading tasks 

Creating load No. 1 

To set the load from the slab's own weight, click the   – Add own 

weight button (Load panel, on the Create and edit tab). The Add own 

weight dialog box will appear (Fig. 61). 
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Fig. 61 – Add Custom Weight dialog box 
 

In this window, with the All circuit elements radio button selected and 

a load reliability factor of 1 specified, click the Apply button  
(depending on the specified volumetric weight Ro, the elements of the 
design circuit are loaded with their own weight) – Fig. 62. 

 

 
 

Fig. 62 – Load 1 – dead weight of the slab (constant) 
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Creating load No. 2 
Change the number of the current load by clicking the Next load 

button  in the status bar (in the lower area of the working window). 

On the Load panel (Create and Edit tab), select the Load command, 

and from the drop-down list, select the Load to Plates command (Fig. 63). 
 

 
 

Fig. 63 – Load drop-down menu 
 

In the Load Assignment dialog box (Fig. 69), specify the coordinate 

system – Global, the direction of load action – along the Z axis. 

  To specify a uniformly distributed variable quasi-steady load, click 

the command button  , the Parameters window appears, in 

which you enter the load intensity – P = 0.35 kN/m2 (Fig. 64) and click the 

button   – Confirm.  
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Fig. 64 – Load Assignment and Parameters dialog boxes 

 

Use the button   to select all elements of the slab. In the Load 

Assignment dialog box, click the button   – Confirm. A uniformly 

distributed quasi-steady load with an intensity of 0.35 kN/m2 will be applied 

to the slab (Fig. 65). 
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Fig. 65 – Load 2 – quasi-steady 
 

Loading formation No. 3 

Change the current loading number by clicking the button   – 
Next loading in the status bar (in the lower area of the working window). 

On the Loading panel (Creation and Editing tab) select the 

Loading command, and from the drop-down list – the Loading on plates 
command. 

 
To set a uniformly distributed variable short-term 

load, click the command button , the 
Parameters window appears (Fig. 66), in which you 
specify the load intensity – P = 1.15 kN/m2 and click 

the button   – Confirm.  
 

 
 
 
Fig. 66 – Options dialog box 
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Use the button  to select all elements of the slab. In the Load 

Assignment dialog box, click the button . A uniformly distributed short-
term load with an intensity of 1.15 kN/m2 will be applied to the slab (Fig. 67). 

 

 
 

Fig. 67 – Load 3 – short-term 
 

 

To specify additional information about the upload, use the   

– Upload Editor button on the Upload panel. The Download Editor dialog 
box will appear (Fig. 68), in which, for download 1, select Permanent from 

the View list in the Edit selected download field and click the   – 
Confirm button. 

For download 2, in the Edit Selected Download field, select 

Permanent from the View list and click the   – Confirm button. 

For download 3, in the Edit Selected Download field, select Short-

term from the View list and click the   – Confirm button. 
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You can also set advanced download information before creating 
downloads. 

 

 
 

Fig. 68 – Download Editor dialog box 
 

 

Generating the DCF table 
 
 
Before starting the calculation, it is necessary to create a table of 

design load combinations. This is done when several loads of different 
durations are specified. According to building codes, reinforcement 
calculations must be performed for the most dangerous combinations of 

forces. Therefore, for further work in the Reinforced Concrete Structures 
mode, calculations must be performed for DCF or DCL. 
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The calculation of design force combinations (DFC) is performed 
according to the criterion of extreme stress values at characteristic points of 
element cross-sections based on the rules established by regulatory 
documents (unlike the calculation of DFC, where the latter are performed by 
directly summing the corresponding values of node displacements and 
forces in the elements). 

 

The dialog box is opened by clicking the button   – DCF Table 
(DCF panel on the Calculation tab) – Fig. 69. 

In the Building Standards field, select DBN V 1.2-2:2006, which is 
valid in Ukraine, from the drop-down list. For each load, specify the type of 

load and click  the button   – Confirm. 
 

 

Fig. 69 – Design Combinations of Forses dialog box 

 

Complete slab calculation 

Before starting the calculation, it is recommended to save the created 

calculation scheme. To perform the calculation, click the  button . 
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Laboratory Work No. 5 

 

Analysis of static calculation results and slab design 
 

Purpose and plan of the session 
 
Perform an analysis of the static calculation results. Display the 

isopoles of displacements and stresses from each load on the screen. 
Create tables of calculation results for the DCF. 

Select reinforcement for the plate elements of the calculation 
scheme. Review the results of the reinforcement selection on the screen 
using the appropriate commands. Create tables with the results of the 
selected reinforcement. Analyze the results for different design options. 

 

Review and analysis of static calculation results 
 

Static calculation results are reviewed and analyzed on the Results 
tab. By default, in the results review mode, the calculation diagram is 
displayed taking into account node displacements (Fig. 70). 

 

 
 

Fig. 70 – Calculation diagram of the slab taking into account the 
displacement of nodes 

 
To display the diagram without numbering elements and nodes, 

applied loads in the Display dialog box with the Elements tab active, you 
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need to uncheck the Element numbers option, the Node numbers option 

on the Nodes tab, and the Loads option on the General tab. 

 

Displaying displacement isopoles 

To display displacement isopoles in the Z direction (Fig. 71), select 

the command   – Displacement isopoles in the global system, click the 

button   – Displacement isopoles along Z (Deformations panel on the 

Results tab). 

 

 

 

Fig. 71 – Isopole of displacements along Z 

 

Displaying stress isopoles 

To display the stress isopoles along Mu (Fig. 72), select the 

command    – Stress isopoles, then click the button   – Stress 

isopoles along Mu (Stress in plates and solid FE panel on the Analysis 
tab). 



 

53 

 

 

Fig. 72 – Stress isofields along Mu 

 

Changing the current load number 

In the status bar (by default, it is located in the lower area of the 

working window), select load No. 2 in the Change load number list, then No. 

3, analyzing the calculation results for each.   

Generating and viewing tables of static calculation results 

To display tables with the values of calculated force combinations in 

the elements of the diagram, select the command  – Interactive Tables 

from the drop-down list Documentation (Tables panel on the Analysis 

tab) – Fig. 73, a. In the Form Editor dialog box (Fig. 73, b), select the RCS 

(bars) row and click the   – Confirm button. 
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         а)                                                               b) 

Fig. 73: a – command to open the Interactive Tables dialog box; b – Forms 
Editor dialog box 

         

The program will generate tables with the results of static slab 
calculation – design load combinations (DLC) in FE (finite elements) of the 
calculation scheme (Fig. 74).         

 
 

Fig. 74 – Table of DCF in slab elements 
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Slab design 

Review and analysis of reinforcement calculation results 

 
After calculating the task, review and analyze the reinforcement 

results on the Design tab. To select reinforcement in the diagram elements, 

click the   button on the Calculate panel.  

 

To view information about the selected reinforcement in one of the 

plate elements, click the   – Node or Element Information button on the 

Selection Panel toolbar and point the cursor at any plate element. In the 

dialog box that appears, go to the Longitudinal reinforcement tab (this 

window contains complete information about the selected element, 

including  the results of reinforcement selection).  Close the dialog box by 

clicking on the button  – Close.  

Viewing selected reinforcement 

To view the area of the bottom reinforcement in the plates in the X1 

axis direction, click the button  – Bottom reinforcement in plates along 

the X1 axis (Plate Reinforcement panel on the Design tab) – Fig. 75.   

To view the area of the lower 
reinforcement in the plates in the Y1 

axis direction, press the button  – 
Lower reinforcement in plates along 
the Y1 axis (Fig. 76). 

 
Fig. 75 – Plate reinforcement panel 
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Fig. 76 – Bottom reinforcement in plates along the Y1 axis 

Forming and viewing tables of reinforcement selection  

 
From the drop-down list 

Documentation (Fig. 77), select 

the command Tables of results 

(Tables panel, Design tab), call 

the dialog box Tables of results 

(Fig. 78). In this window, in the 

Elements field, click the Plates 

button. 

 
 

 
 
 
 
 
 
Fig. 77 – Calling the Table of 
Results command for RC 

 
Changing the design option number 
To view and analyze the results for other design options, open the Design 

Options dialog box by clicking the Design Options button  (Design tab 
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on the Design panel). To switch to another design option, select the 
corresponding line in the List of Design Options for the Schematic in the 

Status Bar. 
 

 
 

Fig. 78 – Tables dialog box 
 

By default, the radio button is enabled for all items in the Create 
Table field (if necessary, you can select the items that interest you and 
enable the radio button for the selected items). When you click the Table 
button, the command to add the created table to the Report Book will be 
executed on the screen. Fig. 79 shows a table with the results of the 
selected reinforcement in the plates (for the first design option). 
 
 

 
 

Fig. 79 – Table of reinforcement results in plates 
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Topic 4. Calculation of a reinforced concrete frame of a multi-story 

building. Design of columns and beams 

Task. Perform calculation of transverse reinforced concrete frame (Fig. 80) 
for static loads (Figs. 82-85). Perform the calculation for the following loads: 

•    first – from the dead weight of the structures; 
•    second – snow (evenly distributed over the roof) – q2= 8.48 kN/m; 
•    third – from the weight of equipment (evenly distributed on the floors in 
the extreme spans) –  q3= 30 kN/m; 
•    fourth – from the weight of equipment (evenly distributed on the floors in 
the middle spans) –  q4= 30 kN/m; 
•    fifth – wind from the right – P1 = 2.88 kN/m; P2 = 3.3 kN/m. 

Each load should be formed separately. 

 

 
 

Fig. 80 – Frame diagram 
 
 
 
 
 
 
 
 
 
 
 

 
 

Fig. 81 – Cross-sections of frame 
elements 
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Рис. 87 – Завантаження №2 

 

 

 

 

 

 

Рис. 88 –  Завантаження №3 

 

 

 

 

 

 

Рис. 89 –   Завантаження №4 

 

 

 

 

 

 

 

Рис. 90 –  Заватаження №5 

Fig. 82-85 – Frame element load diagrams 

 

 

 

Laboratory Work No. 6 

 

Creating a calculation model  

 
Purpose and plan of the session 

 
Creating a new task. Generating a geometric diagram of the frame. 

Setting boundary conditions. Selecting a design option. Setting stiffness 
parameters and material parameters for the elements of the diagram. 
Forming loads on the frame elements. Generating a table of calculated 
force combinations. Setting calculated cross-sections for the beams. 
Complete calculation of the frame.  
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Creating a new task  
 

On the Quick Access Toolbar, click the   – New button. In the 

Diagram Description dialog box, enter the name of the task: “Flat Frame,” 

and in the Diagram Type list, select the line  2 – Three degrees of freedom 

in a node (X, Z, Uy displacement). Click the   – Confirm button. 
 

Creating a geometric frame diagram 
 

On the Creation panel (Creation 

and Editing tab), select the   – 

Frame Generation button and 

Frame Generation in the drop-
down list. 

The Create Flat Fragments 

and Meshes dialog box appears 
(Fig. 86), in which you can set the 
frame parameters: 

•    step along the first axis 
(X) – L= 6 m; 

•    number – N=3; 
•    step along the second 

axis (Z) – L= 3.6 m; 
•    number – N= 3. 
 

 
 
Fig. 86 – Create plane fragments 
and grids dialog box 

 

After clicking the Apply button , the created frame will appear (Fig. 
87). 
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Fig. 87 – Geometric diagram of the frame with dimensions, 

numbering of nodes and elements 
 

 
After creating a diagram (especially if it 

has been edited by adding or deleting nodes 
and/or elements), it is recommended to 
perform repackaging by clicking the  

Repackage Diagram button  on the Edit 
panel.  

 

In the Pack dialog box (Fig. 88), click the 

Apply button , and the program will 
renumber the nodes and elements of the 
diagram. 

You can pack the diagram multiple times 
at any stage of creating and editing the 
calculation diagram. 

 

Fig. 88 – Packaging dialog box 
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Setting boundary conditions 
 

To mark nodes №№1-4 (nodes connecting 

columns to foundations), click the button   – 

Mark nodes on the Selection Panel (by default, it 
is located in the lower area of the working 
window). The nodes will be colored red. Next, 

click the command button  – Restraints 

(Rigidity and Restraints panel on the Create and 
Edit tab), and the Restraints in Nodes dialog box 
will appear (Fig. 89). 

In this window, activate the constraint 
parameters, i.e., the directions in which node 
movement is prohibited (X, Z, UY), and click the 

Add Constraints to Selected Nodes button . 
The nodes will turn blue, which means that the 
boundary conditions (constraints) have been set.   

 

Fig. 89 – Constraints at Nodes dialog box 

 

 

 Selecting a calculation and design option 

 

For structural calculations in accordance with current standards, click 

the  button  – Design options and select the required standard in the 

Design options dialog box (Fig. 90) – DBN V.2.6-98:2009. In the same 

window, specify the calculation option (by individual forces or by design load 

combinations – DCL (or forces – DCF). In this task, it is necessary to 

perform calculations for several loads, so select DCF. 
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Fig. 90 – Design Options dialog box 
 

Setting stiffness parameters and material parameters for 

diagram elements 

Click the Stiffness and Materials button  (Stiffness and 

Connections panel on the Create and Edit tab) to open the Stiffness and 

Materials dialog box (Fig. 91).  

In this window, click the Add button and in the Add Stiffness dialog 

box, select the first tab – Standard Cross-Sections, activate the Beam 
cross-section. 
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а                                            b 

Fig. 91 – Dialog boxes: a – Stiffnesses and materials, 
b – Add stiffness 

 
In the Standard Cross-Section Settings dialog box (Fig. 92), enter the 

following data for the column: 

- modulus of elasticity of concrete class C16/20 – E = 2.7e7 kN/m2 

(for English keyboard layout); 

- geometric dimensions – W = 40 cm; H = 60 cm; 

- specific weight of the material - Ro = 25 kN/m2. 

To see a sketch of the cross-section being created with all 

dimensions, click the Draw button.  

Press the Apply button  to confirm the data entry. 
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Fig. 92 – Dialog box for specifying a standard cross-section (rectangle) 

 

Next, in the Stiffness and Materials dialog box, go to the 

Reinforced Concrete tab to set the parameters for reinforced concrete 

columns. To do this, select the Type radio button, then click the Edit button. 

This will bring up the Materials for Reinforced Concrete Structures 

Calculation dialog box. 

In the Materials for reinforced concrete structures calculation 
dialog box (Fig. 93), specify the following parameters for columns:  

•    in the Bar field: 
-    name – Column; 
-    reinforcement – symmetrical (since the column is centrally 

compressed); 
-    select corner bars; 
-    design length –  specify the coefficient – 0.7; 
•    in the Concrete field – select class C16/20 from the list; 
•    in the Reinforcement field – select class A400C for longitudinal 

reinforcement and A240C for transverse reinforcement from the list. 
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Press the Apply button  to confirm the data entry. 
 

 
Fig. 93 – Materials dialog box for calculating reinforced concrete structures 

(for columns) 
 

         To assign stiffnesses and materials to 
columns, mark all vertical frame elements. The 

latter will be colored red. In the Stiffnesses 

and Materials dialog box, click the Apply 

button . The selection is removed from 
the elements, which means that they are 
assigned the first stiffness type – 1. 40x40 
beam (columns).   
 To set the second type of stiffness (for 
beams), activate the Tavr_T cross-section in 

the Add Stiffness dialog box. In the Set 
Standard Cross-Section dialog box (Fig. 94), 
enter: 
- elastic modulus –  
E = 3e7 kN/m2; 
- geometric dimensions –  
B = 20 cm; H = 60 cm;  
B1 = 40 cm; H1 = 20 cm;  
- density - Ro = 25 kN/m2. 
 

Fig. 94 – Dialog box Setting the standard cross-section (tavr) 
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To see a sketch of the cross-section being created with all 
dimensions, click the Draw button.  

Press the Apply button   to confirm the data entry.  
To create stiffnesses and materials for beams, double-click on the 

second type of stiffness (tavr), assigning it as current (Fig. 95). On the Z/b 
tab, click the Edit button. 

 

 
Fig. 95 – Created list of stiffnesses for frame elements 
 

In the Materials for reinforced concrete structures calculation 

dialog box (Fig. 96), click the Add button  to create parameters for 

beams: 

• In the Bar field: 

- Name – beam; 

-    reinforcement – asymmetric; 

-    do not select corner members; 

-    design length coefficient – 0; 

• In the Concrete field, select class C20/25 from the list. 



 

68 

 

• In the Reinforcement field, select longitudinal class A400C and 

transverse class A240C from the list. 

Click the Apply button to confirm the data entry. 
 

 
Fig. 96 – Materials dialog box for calculating reinforced concrete 

structures (for beams) 
 

Select horizontal elements (beams). In the Stiffness and Materials 

dialog box, the second stiffness type should be current – Tavr¬¬_T 20x60 

(beams) with the appropriate materials for construction. Click the Apply 

button . 

                  Forming loads 

According to the task, you need to calculate the frame for five loads. 

For convenience, it is recommended to display the element numbers using 

the button  button to open the Display dialog box, and check the 

Element numbers command on the Elements tab. 

 

Creating load No. 1 

To set the load from the frame elements' own weight, click the   – 

Add own weight button (Load panel on the Create and edit tab). The Add 

Own Weight dialog box will appear, in which you click the  – Apply 
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button (depending on the specified volumetric weight, the elements of the 

calculation scheme are loaded with the load from their own weight) – Fig. 

97. 

 

 
Fig. 97 – Load 1 – dead weight (constant) 

 
Creating load No. 2 

According to the task, the second load is variable short-term (snow) 

with an intensity of 8.48 kN/m. Change the number of the current load by 

clicking the Next Load button  in the status bar (in the lower area of 

the working window). 

On the Load panel (Create and Edit tab), select the Load 

command. From the drop-down list, select the Load on Bars command 

(Fig. 98). 
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Fig. 98 – Load on bars command in the Load drop-down list 
 
 

In the Load Assignment dialog box (Fig. 99), specify the coordinate 

system – Global, the direction of load action – along the Z axis. 

  To specify a linear load uniformly distributed along the length of the 

beam, click the command button , the Parameters window 

appears, in which you specify the load intensity – P = 8.48 kN/m (Fig. 99) 

and click the button   – Confirm. 
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Fig. 99 – Load Assignment and Parameters dialog boxes 
 

Use the button   to select horizontal elements  Nos. 19-21 (roof 

purlins). In the Load Assignment dialog box, click the button  . A snow 

load with an intensity of P=8.48 kN/m will be applied to the frame (Fig. 100). 
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Fig. 100 – Load 2 – snow (short-term) 

Forming loads No. 3 and 4 

According to the task, the third and fourth loads are variable quasi-
constant loads depending on the weight of the equipment, with an intensity 
of P=30 kN/m. Change the number of the current load by clicking on the 

button   – Next load in the status bar (in the lower area of the working 
window). 

On the Load panel (Creation and Editing tab), select the Load 

command, and from the drop-down list, select the Load on Bars 
command. 

  To specify the linear load, click the command button  

specify the load intensity in the Parameters window – P=30 kN/m, and click 

the button   – Confirm.  

Use the button  to select horizontal elements Nos. 13, 15, 16, and 

18 (for the third load). In the Load Assignment dialog box, click the button 

. A long-term load from the weight of equipment with an intensity of 
P=30 kN/m will be applied to the beams of the extreme spans of the 2nd 
and 3rd floors of the frame (Fig. 101). 
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Fig. 101 – Load 3 – from equipment (long-term) 

 

For the fourth load, repeat the steps described above, but apply the 
load to elements Nos. 14 and 17 (Fig. 102). 

Formation of load No. 5 

The fifth load is a variable short-term (wind) load with an intensity of 
2.88 and 3.3 kN/m. Change the number of the current load by clicking on 

the button  – Next load in the status bar (in the lower area of the 
working window). 

 
Fig. 102 – Load 4 – from equipment (long-term) 
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On the Load panel (Create and Edit tab), select the Load 

command, and from the drop-down list, select the Load on Rods 
command. 

In the Load Assignment dialog box, specify the coordinate system – 
Global, the direction of load action – along the X axis. To create a load, 

click the command button  – On a group of elements, the 

Uneven Load window appears, in which you specify with a radio button 
along which axis (Z) the load (wind pressure) will increase and the load 

intensity – P1=2.88 kN/m, P2=3.3 kN/m and click the button   – Confirm.  
 

Use the button   to select vertical elements  Nos. 10-12 (columns on 

the far right axis for the entire height of the frame). In the Load 

Assignment dialog box, click the button  . A wind load will be applied 
to the frame on the right (Fig. 103). 
 

 
 

Fig. 103 – Load 5 – wind from the right (short-term) 
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Request for additional information about the load 

 
To specify additional information 

about the load, use the button 

 on the Load panel. The 

Download Editor dialog box will 

appear (Fig. 104), in which, for 

download 1, in the Edit selected 

download field, specify the name 

– Own weight, select Constant 

from the Type list, and click the  

button .  

 
 
 
 
 
 
 
 
Fig. 104 – Download Editor dialog 
box 

 
 
 
 

For download 2, in the Edit Selected Download field, enter the 

name Snow, select Short-term from the Type list, and click the button .  
For downloads 3 and 4, enter the name Equipment Weight in the 

Edit Selected Download field, select Long Term from the Type list, and 

click . 
 

To load 5, in the Edit Selected Load field, enter the name – Wind 

from the right, select Short-term from the View list, and click the button . 
You can also enter additional information about the load before 

generating the loads. 
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Generating the RSD table 

 
Since several loads of different durations have been specified, it is 

necessary to create an DCF table for further calculation of reinforcement for 
the most dangerous combinations of forces.  

The dialog box of the same name is called up by clicking on the 

button   – DCF table (DCF panel on the Calculation tab) – Fig. 105. 

 
Fig. 105 – Calculated force combinations dialog box 

 
In this window, for the selected building codes DBN V.1.2-2:2006, 

you need to specify the relevant data for each load.  
For loads 3 and 4, enter 1 in the text field No. of mutually exclusive 

loads, and for wind load, check the box Consider sign change. Save the 

table by clicking the button . 
 

Specifying design cross-sections for beams 

 
Mark all horizontal elements on the diagram. On the Members 
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context tab, on the Edit Members panel, click the button   – Design 

cross-sections of members. The Design Cross-Sections dialog box 
appears (Fig. 106), in which you specify the number of design cross-
sections N = 5 (to design a bending element, you need to calculate the 

forces in three or more cross-sections). Click the  – Apply button. 
 

 
 
 
 
 
Fig. 106 – Calculated Cross-Sections dialog box 

 

 

Assigning structural elements 

 

To create a BEAM structural element, 
select the horizontal elements of the 
beams, for example, on the top floor. 
 
 
 
 
 
Fig. 107 – Structural Elements dialog 
box 

 
 
 

Open the Structural Elements dialog box by clicking the Structural 

Elements button  on the Beams context tab.  
 

In the dialog box, in the Edit CoE field, click the Create button (the 
BEAM structural element is used to indicate that this is a continuous beam).  

To create a COLUMN structural element, select vertical elements to 
a height of three floors, for example, along the axis on the left. In the 

Structural Elements dialog box, in the Edit CoE field, click the Create 
button (the COLUMN structural element is used to indicate that this is a 
continuous column).  
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Fig. 108 – Frame with created structural elements 
 
 

Complete frame calculation 
 

Before starting the calculation, you need to save the task (button 

 on the quick access panel). To calculate, click on the button  – 
Perform calculation. 

 
 

Laboratory Work No. 7 

 

Analysis of static calculation results and frame element design 

 

Purpose and plan of the session 
 

Display the displacement and force diagrams in the frame elements 

for each load. Analyze the results of static calculation. Create PCS tables. 

Analyze the selected reinforcement for vertical and horizontal elements of 

the calculation scheme (columns and beams). Create tables of results for 

reinforced concrete elements. Design columns and beams. 
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Review and analysis of static calculation results 

 
After calculating the problem, review and analyze the static 

calculation results on the Analysis tab. 
In the calculation results review mode, the calculation diagram is 

displayed by default, taking into account node displacements. To display the 
diagram without taking into account node displacements, click the   – Initial 

Diagram button  (Deformations panel on the Analysis tab). 

 
Displaying internal force diagrams on the screen  

 
To display the longitudinal force diagram in the frame elements N, 

click the button  – Longitudinal force diagrams N (Force in members 

panel on the Analysis tab). To shade the diagrams and display the force 

values, use the  button  button to open the Display dialog box. On the  

tab  – Values, check the boxes next to the commands  – Show 

shaded diagrams and  – Values on diagrams. 
 
 

 
 

Fig. 109 – Diagram of longitudinal forces in frame elements (dead 
load) 
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To display the My diagrams, click the button   – My bending 

moment diagrams (Force in members panel on the Analysis tab) – Fig. 
110. 

 

 
 

Fig. 110 – Diagram of bending moments in frame elements (loading 
with own weight) 

To display the Qz diagrams, click the button   – Qz shear force 

diagrams (Force in members panel on the Analysis tab) – Fig. 111.  

Sometimes it is more convenient to analyze the forces in the 

elements of the calculation scheme in the form of a mosaic (in color). To do 

this, select the command  – Mosaic of forces in members in the 

Diagrams/mosaic list (the Forces in members panel on the Analysis tab) 

– Fig. 112. 
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Fig. 111 – Diagram of transverse forces in frame elements (loading by own 
weight) 

 

  Fig. 112. Forces in Bars panel 
 
 

Changing the current load number 
 
To view the force diagrams for the next load in the status bar, select 

the row corresponding to the second load in the Change load number list 

and click the Apply button . 
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Generating and viewing calculation result tables  
 
To view the force diagrams from the next load in the status bar in the 

Change load number list, select the line corresponding to the second load 

and click the Apply button . 
Creating and viewing tables of calculation results  

To display a table with the values of calculated forces in the elements 

of the diagram, click the button  – Documentation (Tables panel on 

the Analysis tab), select the Interactive Tables command from the 

Documentation drop-down list (Fig. 113).  

 

 
 
Fig. 113 – Calling the Interactive Tables command 
 

The Form Editor dialog box will appear, in which you select the DCF 

bars ribbon (Fig. 120), and in the Create DCF Table window, select the 
desired option – for all elements or only for selected ones (in which case 
these elements must be selected in advance). Confirm the operation. 
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Fig. 114 – Form Editor and Create Table dialog boxes 
 
 
The program will generate a table of calculated force combinations 

(Fig. 115). 
 

 
 

Fig. 115 – Table of reinforcement in frame elements (fragment) 
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Review and analysis of reinforcement selection results 

 
Reinforcement calculation 

After calculating the problem, go to the RC tab to view and analyze 
the reinforcement results. To select reinforcement in the diagram elements, 

click the Calculate button  (Analisis panel on the RC tab). In the 

Reinforcement calculation dialog box, click the Perform calculation 
button.  

 
Viewing reinforcement results  
To view information about the selected reinforcement in one of the 

elements, click the   – Node or Element Information button on the 

Selection Panel toolbar, pointing the cursor at the desired element. In the 
dialog box that appears, go to the Longitudinal reinforcement tab (this 
window contains all the information about the selected element, including 
the reinforcement selection results).  

To set the display mode for symmetrical reinforcement in column 

cross-sections, select the Symmetry command from the drop-down list on 

the Bar Reinforcement panel in the RC tab (Fig. 48).  
The user can customize the reinforcement display mode at their 

discretion—as a mosaic or reinforcement diagram (Fig. 48).  
 
An algorithm for selecting corner bars was set up for the columns. To 

view the areas of longitudinal reinforcement in the lower left corner of the 

AU1 bar cross-section, click the  – AU1 corner reinforcement button. 

To view the areas of longitudinal reinforcement in the lower right 

corner of the AU2 bar cross-section, click the  button  – AU2 corner 

reinforcement. 

To set the display mode for asymmetrical reinforcement in beam 

cross-sections in the form of reinforcement diagrams, select the 

Asymmetry command from the drop-down list on the Reinforcement 

panel in the Design tab. Since the distributed reinforcement mode was set 

for beams, to display the results of the lower reinforcement (in spans), click 

the Distributed reinforcement AS1 button  (Fig. 116).  
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Fig. 116 – Distributed reinforcement AS1 (near the lower edge of the 

section) in beams 

 

To display the results of the upper reinforcement (on the supports), 

click the button  – Distributed reinforcement AS2 (Fig. 117). 

 

 
Fig. 117 – Distributed reinforcement AS2 (near the upper edge of the cross-

section) in beams 
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Forming and viewing tables of reinforcement selection results 

 

On the Design tab, from the Tables panel  – Analisis, activate the 

Results tables for reinforced concrete command from the drop-down list.  

In the Results tables dialog box, a table with the results of the selected 

reinforcement is displayed on the screen (Fig. 118). 

 

 
 

Fig. 118 – Table with the results of the selected reinforcement 
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Topic 5. Design a monolithic beam floor slab. Design a slab and 

secondary beam 

Task. Calculate the static load on a monolithic floor slab. Analyze the 
calculation results. Select the reinforcement. 

The structural diagram is shown in Fig. 119. The floor material is 
C16/20 concrete, reinforced with separate A400C reinforcement bars.  

 
Perform the calculation for a 27x24m slab (36x12 grid) in the xOy 

plane for two loads: 
•    first load – constant uniformly distributed 
       g= 2.4 kN/m2, including dead weight; 
•    second load – variable (long-term) uniformly distributed                    

p= 7.5 kN/m2. 
 

 
 

Fig. 119 – Scheme of a monolithic ribbed floor with beam slabs 

 

Design Guidelines 
 
The design of reinforced concrete floors is carried out in the following 

sequence: 
1.    Layout of the building/structure. At this stage, a structural 

diagram is developed, the main load-bearing elements are determined, their 
dimensions are specified, etc. 

2.    Static calculation. Based on the approved structural diagram, a 
calculation diagram is selected, all loads and influences are determined, 
and the forces in the system elements are determined. 

3.    Calculation of cross-sections. Based on the acting forces, the 
dimensions of the cross-sections of the elements are selected or the 
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previously assigned dimensions are checked to see if they are sufficient to 
withstand the forces. 

4. Design. Determine the reinforcement schemes for the elements 
and create drawings of reinforcement and embedded products. 

 

 
Fig. 120 – Calculation of a monolithic ribbed floor with beam slabs: 

1 – main beam Bm-1; 2 – secondary beam Bm-2; 3 – column Km;  4 – 
design strip of slab Pm; 5 – load strip of secondary beam 
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Fig. 121 – Calculation of the slab:  

a – structural diagram; b – calculation diagram 

 

 

Laboratory Work No. 8 

 

  Creating a calculation model of a beam floor slab 
 

Purpose and plan of the session 

 Create a new task. Generate a slab, main and secondary floor beams. Set 
boundary conditions (support conditions). Create calculation and design 
options. Set stiffness characteristics and material parameters. Review the 
spatial model of the floor. Check the types of finite elements. Set the load. 
Perform a complete calculation of the slab. 

Creating a new task          

To create a new file, click the   – New  button on the quick access 

toolbar. In the Diagram Description dialog box, specify the Diagram Type – 

5 – six degrees of freedom in the node (X, Y, Z, Ux, Uy, Uz displacement),  
the task name: “Monolithic beam floor” and, if desired, a description of the 
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task (Fig. 122). Press the  

button   – Confirm.        

 

 
 
 
 
 
 
 
 
Fig. 122 – Model type dialog 
box 

 

Creating a geometric slab schematic 
 

On the Create and Edit tab, click   – Generation of flat fragments 
and meshes in the drop-down list and select the Slab Generation command 

(Fig. 123). 
 

In the Create Flat Fragments and 

Meshes dialog box, create a 36x12 
finite element model by specifying the 
following parameters: 

step along the first axis: L(m) – 
0.75;   N  –  36; 

step along the second axis:  
L(m) –  2;  N  –  12.  

Leave the rest of the parameters 

as default and click   – Confirm. 

 
 
 
 
 

 
Fig. 123 – Create Planar Fragments 

and Meshes dialog box, Slab 
Generation tab 

 

Тo model beams, on the Create and Edit tab, click the Add Element 
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button  and select Add Member from the drop-down list. A dialog box 
with the same name will appear (Fig. 124). On the diagram of the newly 
created slab, add members in the places where secondary and main beams 
should be (the step of secondary beams is 2.25 m, main beams – 6 m). The 
geometric diagram of a monolithic beam floor is shown in Fig. 125. 

 

 
 

 

Fig. 124 – Drop-down list Add Bar 
 
 

To save information about the created model, click the button  on 

the quick access toolbar. 

Setting boundary conditions (constraints) 

After activating the command button  – Node Marking, select the 

nodes supporting the slab on the two shorter sides (those supported by the 

main beams) with the cursor; the nodes will be displayed in red. To set 

boundary conditions, call the Restraints in nodes dialog box by clicking the 

Restraints button  (Stiffness and restraints panel on the Create and 

edit tab).           
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Fig. 125 – Geometric diagram of a monolithic beam floor 

In the dialog box, select the directions in which node movements are 

prohibited (X, Y, Z, UX, UY, UZ – pinching) and click the button  – Add 

ties at the selected nodes. The color of the nodes will change from red to 

blue, indicating that the command has been executed (Fig. 126). 
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Fig. 126 – Setting the joints on the shorter sides of the slab 

 

After that, select the slab support nodes on the longer sides and the 

nodes at the intersections of the longitudinal beams with the columns, 

prohibit movement in the Z direction (hinged support) – Fig. 127 – and 

press the button . All ties are set. 

Setting calculation and design options 

For structural calculations, click the  button – Design options 

(Design panel on the Create and Edit tab). In the Design Options dialog 

box, set the parameters for design (selection of reinforcement based on the 

strength of normal sections). In the same window, select the calculation 

option (based on the calculated combinations of forces - PCF) and the 

applicable standards. Click the  button  - Apply. 

 



 

94 

 

 

 
Fig. 127 – Specifying joints in the supporting nodes of the floor slab 

 

Creating and assigning stiffnesses and material parameters 

Click the button . In the Stiffnesses and Materials dialog box, 

form a list of stiffness types. Assign the stiffness type Plate H7 to the slab 

elements. Longitudinal (main) beams have the cross-section type Beam 

30x80, transverse (secondary) beams – Beam 20x40 (Fig. 128). 

On the Reinforced concrete (RC) tab of the Stiffness and materials 

dialog box, you need to specify the parameters for reinforced concrete 

structures: type, concrete, reinforcement. 

Select the Type radio button and click Edit.  
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Fig. 128 – Specifying stiffnesses for slabs and beams 
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The Materials for Calculating Reinforced Concrete Structures 
dialog box will appear, in which you should left-click in the Plate field. In the 
upper right corner, specify: calculation type – Slab (bending), set the 
reinforcement bar spacing – 200 mm. In the Concrete field, select concrete 
class C16/20, in the Reinforcement field: longitudinal – class A400C, 

transverse – A400C. To save the entered data, click the   – Confirm 
button. 

 

 
Figure 129 – Dialog box Material properties for analysis RC 

structures 
 

After assigning stiffnesses for correct beam placement, rigid inserts 
must be entered. Rigid inserts are entered along the local Z-axis with a size 
equal to half the height of the cross-section of the bar element. That is, for 
main beams it is 0.4 m, and for secondary beams it is 0.2 m. 

To specify stiffeners, first select the main beams and then select the 

Stiffener command from the Stiffness drop-down menu (Fig. 130). In the 
dialog box for assigning rigid inserts (Fig. 131), enter the value -0.4 in the 

first and second nodes and press . Perform the same operation for 
secondary beams (enter the value -0.2). 
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Fig. 131 – Offsets for bars dialog box 
 

 
 
Fig. 130 – Setting the Rigid Rod Inserts command 
 

 
To check the correctness of the calculation model, activate the 

Spatial model (3D graphics) command in the program menu. A spatial 
image of the beam floor will appear on the screen (Fig. 131). 

 

 
Fig. 131 – Spatial model of a beam floor 
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Checking the finite element (FE) type 

 

Use the polyfilter (button   on the 
selection panel) to check the KE type. In 

the Filter for Elements dialog box, check 
the box next to KE Type (Fig. 132). 
Review the list. It should display two types: 
10 – universal spatial bar (for beams) and 
11 – rectangular FE slab (for slab 
elements). If necessary, the FE type can 

be changed using the command  – 

Change FE type (Advanced editing tab, 

Diagram panel). 

 

 

 

 

Fig. 132 – Polyfilter dialog box 

 

 

Load assignment 
Load generation №1 
 

On the Load panel (Create and 

Edit tab), select the Load command, and 

from the drop-down list, select the Load 

on Plates command. 

In the Load Assignment dialog box, 
specify the coordinate system – Global, 
the direction of the load – along the Z axis. 

 
 
 
 

 
Fig. 133 – Options dialog box 
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To set a uniformly distributed variable quasi-steady load, press the 

command button  , the Parameters window appears, in which 

enter P= 2.4 kN/m2 (Fig. 133) and press the button   – Confirm. 
 

Using the polyfilter (button   on the selection panel), select the 

slab elements (to do this, in the Filter for Elements dialog box, check the 
box in the By KE Type field, select Type 11 - Rectangular KE Slab from the 

list, and click the button  (all slab elements will be colored red). In the 

Load Assignment dialog box, press the  button . A uniformly 
distributed load with an intensity of 2.4 kN/m2 will be applied to the slab (Fig. 
134). 

 

 
 

Fig. 134 – Evenly distributed load on the plate 
 

Load generation №2 

Change the number of the current download by clicking – the 
Next Download button in the status bar (in the lower area of the working 
window). 

On the Loads panel (Create and Edit tab), select the Loads 

command from the drop-down list, select the Plate Loads command, and 
set a variable long-term load evenly distributed over the area; for this, in the 
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Parameters window, and set P= 7.5 kN/m2, click the –  Confirm button. 

To specify extended information about the download, use the   

– Download Editor button on the Downloads panel. The Download Editor 
dialog box will appear, in which for download 1 in the Edit selected 
download field, select the Permanent ribbon from the Type list and click the 

 – Confirm button. 
For download 2 in the Edit selected download field, select the Long 

ribbon from the Type list and click the – Confirm button. 

Generation of the DCF table (desing combinations of forces) 

Since the calculation is performed for two loads of different durations, 
creating a table of calculated force combinations is necessary. 

Full slab calculation 

Before starting the calculation, it is recommended to save the created 

calculation scheme. To do this, use the Save button  on the quick 

access panel. To perform the calculation, click the button  – Perform 
full calculation on the Calculation tab.  
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Laboratory Work No. 9 

 

Analysis of the results of static calculation and design of a beam floor 

slab 

 
Purpose and plan of the session 

 
Display the isopoles of displacements and stresses in the plate 

elements of the slab, create tables of calculated force combinations, 
analyze the results obtained.  

Perform calculations to select reinforcement for slab elements. 
Review the mosaics of lower and upper reinforcement. Select working and 
structural reinforcement for the slab based on the tables of automated 
reinforcement selection results. 

 

Review and analysis of static calculation results 

 
The results of the static calculation are reviewed and analyzed in the 

Analysis tab.  
To display the displacement isopole in the Z direction, select the 

command  – Displacement isopole in the global system, click the button   

 – Displacement isopole along Z (Deformations panel on the Analysis 
tab) – Fig. 135.  

To display the stress isopole in the Mu direction, select the command   

 – Stress isopole, then click the button  – Stress isopole in Mu 

(Stress in plates and solid elements panel on the Analysis tab) – Fig. 
136. 
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Fig. 135 – Isofield of displacements along Z 

 

  

Fig. 136 – Stress isofield along Mu 

 

To view the table with the values of the calculated force combinations 

in the elements of the diagram (Fig. 137), select the command   – 

Standard Tables from the drop-down list Documentation (Tables panel on 

the Analysis tab). In the Standard Tables dialog box, select the RCS 

Calculated row and click the   – Confirm button. 
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Fig. 137 – DCF table for slab elements (fragment) 

 

 

Review and analysis of reinforcement selection results 

 

After calculating the task, go to the Design tab to review and analyze 
the reinforcement results. To select reinforcement in the diagram elements, 

click the   - Reinforcement calculation button on the Calculation 
panel.  

 
To view information about the selected reinforcement, use the 

command  – Reinforcement area (Plate reinforcement panel on 

the Design tab).   
To display the selected reinforcement areas per 1 running meter 

along the X-axis near the bottom edge, click the button  – Bottom 
reinforcement in plates along the X1 axis (Fig. 138). 
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Fig. 138 – Reinforcement area per 1 linear meter along the X1 axis 
near the bottom edge 

 
To view the mosaic representation of the area of upper reinforcement 

in the plates along the X1 axis, click the button  – Upper reinforcement 
in plates along the X1 axis  (Fig. 139). Similarly, view the selected 
reinforcement in the direction of the Y1 axis. 

To generate a table with the results of reinforcement selection from 

the drop-down list Documentation, select the command Results tables for 

reinforced concrete (Tables panel, Design tab), call the Results tables 
dialog box, and click the Plates button in the Elements field. A table with the 
reinforcement results will be displayed on the screen (Fig. 140). 

 

 
 

Fig. 139 – Reinforcement area per 1 linear meter along the Y1 axis near  
the upper face 
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Fig. 140 – Table with the results of reinforcement selection in selected slab 
elements 

 

Slab design 
 

It should be remembered that in LIRA, the calculation is performed in 
a linear setting. In the case of slab reinforcement with separate bars with a 
slab thickness of up to 120 mm, separate reinforcement is used, i.e., all 
bars of the span reinforcement are brought to the supports, above which 
their reinforcement is installed. In this case, the lower span bars are 
designed to be continuous, passing through several supports, and in the 
extreme spans, where more reinforcement is required according to the 
calculation, additional bars are installed.  

The working and structural reinforcement of the slab is selected 
according to the tables of results of automated reinforcement selection.In 
addition to the main reinforcement, it is necessary to install additional 
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reinforcement in the non-working direction: near the supports near the walls 
(to absorb partial pinching moments) and above the main beams. The 
amount of this reinforcement is taken to be at least 1/3 of the slab's span 
reinforcement. The length of the reinforcement bars above the beams (both 
main and secondary) is determined on the condition that the horizontal 
sections on each side of the beam edge are equal to 1/4 of the slab span, 
i.e., 500 mm. The length of the pressure rods near the walls is taken on the 
condition that the horizontal sections from the wall are equal to 1/10 of the 
slab span. 

 

Laboratory Work No. 10 

 

Creating a calculation model of a secondary beam  
 

Purpose and plan of the session 

 
Create a calculation model of a secondary beam of a monolithic 

beam floor. Generate tables of design combinations of forces (DCF), 
perform a static calculation, analyze the calculation results. Select 
reinforcement. Take the initial data for the calculation from the previous 
task. 

Task. Perform the calculation for a 24 m long beam for two loads: 
•    the first – constant uniformly distributed g= 7.77 kN/m, including 

its own weight; 
•    second – variable (long-term) uniformly distributed p= 19.24 

kN/m. 

 

Fig. 141 – Design spans, cross-section and diagram of the secondary 
beam 
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Creating a new task 

To create a new file, click the   – New button on the quick access 

toolbar. In the Diagram Description dialog box, specify the Diagram Type 

– 2 – three degrees of freedom at the node (displacement X, Z, Uy) XOZ,  

task name: “Secondary beam.” Click the    –Confirm button. 

 

Creating a geometric diagram of a beam 
 

In the Create Flat Fragments and Meshes dialog box, on the Frame 
Generation tab, specify: step along the first axis L(m) – 24; N  –  1, click the   

button  – Confirm. 
Select the bar with the mouse cursor, divide it into 24 equal elements 

using the Add Element – Divide into N Equal Parts command (Fig. 142). 

 

 
 

Fig. 142 – Add Element – Split command 
 

The resulting geometric diagram of the beam is shown in Fig. 
143.



 

108 

 

 

 
 

Fig. 143 – Geometric diagram of a beam 

 

Setting boundary conditions 

The node numbers on the calculation diagram are displayed on the 

screen. Activate the command button   – Node marking, mark nodes 

No. 1, 8, 14, 20 (they will be displayed in red). To set the constraints, use 

the button  . In the Constraints dialog box, select the directions in 

which node movement is prohibited (Z – hinged support), press    – 

Add constraints to selected nodes. Select node No. 2. In the Connections 

dialog box, select the X and Z directions (hinged-fixed support) and click  

 .  

 

Selecting a calculation and design option  

For structural calculations in accordance with current standards, click the  

button – Design options and select the required standard (DBN V.2.6-
98:2009) in the Design options dialog box. In the same window, specify the 
calculation option (based on the calculated load combinations – DCF). 

Setting stiffness parameters and material parameters for elements of 

the diagram 

Click the button   – Stiffness and Materials (Stiffness and 

Constraints panel on the Create and Edit tab) to open the Stiffness and 

Materials dialog box. In this window, click the Add button and in the Add 

Stiffness dialog box, select the first tab – Standard Cross-Sections, 
activate the Tavr_T cross-section (Fig. 144). 
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In the Standard Cross-Section 
Settings dialog box, specify: 
- elastic modulus for C20/25 
concrete –  E = 3x107 kN/m2; 
- geometric dimensions – B = 20 
cm; H = 40 cm; B1 = 210 cm; H1 
= 7 cm; 
- material density – Ro = 25 
kN/m2. 
To display a sketch of the cross-
section being created, click the 

Draw button, then   – 
Confirm (Fig. 144). 
 
 
 
Fig. 144 – Specifying a standard 
cross-section Dialog box 

 
 

Next, in the Stiffness and Materials dialog box, go to the Reinforced 
Concrete tab to set the parameters for the beam. To do this, select the 

Type radio button, then click the Edit button. In the Materials dialog box 

for calculating reinforced concrete structures, specify the parameters: 
•    in the Bar field: 
-    name – Beam; 
-    reinforcement – asymmetrical; 
-    do not select corner bars; 
•    in the Concrete field, select class C20/25 from the list; 
•    in the Reinforcement field, select class A400C for longitudinal 

reinforcement and A240C for transverse reinforcement from the list. 
Press the Apply button to confirm the data entry. Select all beam 

elements, and in the Stiffness and Materials dialog box, press the Apply 
button. 

Load assignment 
Assign loads according to the task in two loads. On the Load panel, 

select the Load command, and from the drop-down list, select Load on 

members. In the Load Assignment dialog box, use the radio buttons to 
specify the Global coordinate system and the direction of the load action – 
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along the Z axis. Click the uniformly distributed load button  

to open the Parameters dialog box. In this window, enter P = 7.77 kN/m for 
the first load and click the Confirm button. Use the Node Marking button to 

mark all beam elements. In the Load Assignment dialog box, click the 
Confirm button again. 

For the second load, set  P = 19.24 kN/m.  

To set the load information, use the button   - Load Editor on 

the Loads panel, Create and Edit tab. In the Load Editor window for load 

1, in the Edit Selected Load field, select Permanent from the list and click 

the  button . For load 2, select Temporary Long-Term. 

 

Generating the DCL table 

 
To further calculate reinforcement based on design load 

combinations, select the DCL command on the Calculation tab 

(Additional Calculations panel) (Fig. 145). 
 

 
 

 

 

 

 

Fig. 145 – Calling the DCL command 
 

 

The Design combinations of loads dialog box will appear (Fig. 

146), in which you need to click the Add button. For the first main force 

combination, three columns will be automatically created: DCF1, DCF2, and 

DCF3 with load combination coefficients. It is important to remember that 

the loads on the design scheme were specified by design values (important 

for structural calculations). To analyze the deformations of the design 

scheme, you need to use standard loads, so the load combination 

coefficients must be divided by the load reliability coefficients. 
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Fig. 146 – Design combinations of loads dialog box 

 

Complete beam calculation 

Before starting the calculation, you need to save the created 

calculation scheme. To do this, use the button   – Save on the quick 

access toolbar. To perform the calculation, click the button  – Perform 

calculation on the Calculation tab. 

 

 

Laboratory Work No. 11 

Analysis of static calculation results and design of a secondary 

beam 
 

Purpose and plan of the session 

Visualize the results of the static calculation of the beam. Create 
tables. Analyze the diagrams of bending moments and shear forces in the 
beam elements. 

Visualization of calculation results 

To switch to the visualization mode of static calculation results, go to 

the Analysis tab. By default, the deformed beam diagram is displayed. To 

display the initial diagram, click the button  (Deformations panel on the 
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Analysis tab).  

To view the force diagrams, use the command buttons      

(Forces in the bars panel on the Results tab). The force diagrams are 
shown in Fig. 147-148. 

 

 
 

 
Fig. 147 – Diagrams of bending moments and shear forces in beam 

elements from the first load 

 
 

 
Fig. 148 – Diagrams of bending moments and shear forces in beam 

elements from the second load 
 
 
Mark elements No. 3, 7, 10, and 13 on the diagram. Right-click to 

select Standard Tables – Forces – All Loads. The program will generate 
a table of forces for these elements, where the greatest moments occur 
(see Fig. 149). The forces from the DCF are shown in Fig. 150. 

 

 
Fig. 149 – Forces from both loads in selected elements 
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Fig. 150 – Design combinations of loads 

Reinforcement calculation and reinforcement selection 

On the Design tab, click the   button  – Reinforcement 

calculation, on the Bar reinforcement panel, select the Asymmetry 
command to set the display mode for asymmetric reinforcement, click the   

button  to display the lower distributed reinforcement (Fig. 151). 
 

 
 
Fig. 151 – Command to display the lower distributed reinforcement AS1 

 
The program displays the reinforcement diagram near the bottom edge of 
the beam (Fig. 152). 
 

 
Fig. 152 –   Area of lower distributed reinforcement AS1 in the beam 

 

To display the reinforcement at the upper edge, press the button   – 
Fig. 153. 
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Fig. 153 – Command for displaying upper distributed reinforcement AS2 
 

The reinforcement diagram at the upper edge of the beam is shown in Fig. 
154. 

 

 
Fig. 154 – Area of upper distributed reinforcement AS2 in the beam 

 
The table of reinforcement results for secondary beam elements is shown 
in Fig. 155. 

 

Designing a secondary beam 

 

It should be noted that in LIRA, the calculation is performed in a 

linear setting. In the case of beam reinforcement with separate bars, 

longitudinal working reinforcement for span and support sections is first 

selected according to the calculation (see the table of automated 

reinforcement selection results, columns AS1-AS2). Structural (transverse) 

reinforcement is marked as ASW1 in the table. 
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Рис. 155 –  Results of reinforcement selection in selected beam elements 
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Topic 6. Design of metal trusses 

 

Task. Calculate and analyze the stress-strain state in the elements of 
a metal trapezoidal truss made of seamless hot-rolled pipes. Check the 
specified cross-sections and select the cross-sections of the truss 
elements. 
Perform the calculation for the following loads: 1 – dead weight of the roof 
structures; 2 – snow load on the entire span; 3 – snow load on half of the 
truss span.  

 

Laboratory Work No. 12 

 

Creating a calculation model, analysis of static calculation 

results and selection of truss element sections 
 

Purpose and plan of the session 

Create a calculation model. Select a calculation and design option. 
Generate tables of calculated load combinations (LC). Perform a complete 
calculation of the steel truss. 

Review and analyze the results of the static calculation of the truss. 
Create tables. Analyze the diagrams of bending moments and shear forces 
in the truss elements. Analyze the results of checking and selecting the 
cross-sections of the truss elements. Design the truss. 

Creating a new task 

On the quick access toolbar, click the  – New button. In the 

Diagram Description dialog box, enter the name of the task: “Truss 

L=24m,” and in the Diagram Type list, select the line  1 – Two degrees of 

freedom at the node (X,Z displacement). Click the   – Confirm button.  

Selecting a calculation and design option  

 
For structural calculations in accordance with current standards, click 

the  button – Scheme design options and select the required standard 

(DBN V.2.6-198:2014) in the Design options dialog box. In the same 

window, specify the calculation option (based on design combinations of 

forces – DCF).   
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Creating a geometric 

diagram of a truss 

On the Create and Edit tab, click the 

  - Generate Trusses button and 
select the command of the same 
name (Fig. 156). The Create Flat 
Trusses dialog box will appear (Fig. 
157).  

Fig. 156 – Creat Truss dialog box 

In this window, select a truss by the outline of the chords (Fig. 157, a) 
– in our case, to create a trapezoidal truss diagram, press the button 

. To select a truss configuration by the outline of the grid (Fig. 157, 

b), press the corresponding button – . 

        
                        а)                                        b) 

 
Figure 157 – Cenerate 2D truss dialog box: a – select a truss by 
the outline of the belts, b – by the outline of the lattice 
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Fig. 157 – Dialog box for specifying truss parameters 
 

In the dialog box that appears (Fig. 157), you need to specify all the 
numerical parameters that will determine the dimensions of the truss. To 
do this, fill in the appropriate fields:  

 truss length L= 24 m; 
 h = 2 m; 
 parameter K (number of panels) – 8; 
 fi – angle of inclination of the upper chord – 150. 

After that, click on the Draw button. If the user is satisfied with the created 
diagram, click   – Apply, if not – make corrections. The geometric diagram 
of the truss is shown in Fig. 158. 
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Fig. 158 – Geometric diagram of a truss 

 Save the task by clicking the button . In the Save As dialog box, 

specify the folder where this file will be saved. 

Setting boundary conditions 

Activate the  command button  – Node Marking, mark node No. 1 

(it will be displayed in red). To set the constraints, use the  button . In 

the Constraints dialog box, select the directions in which node No. 1 (Z – 

hinged support) is prohibited from moving, click   – Add constraints to 

selected nodes. Next, select node No. 9. In the Constraints dialog box, 

select the X and Z directions (hinged support) and click   . 

 

Setting stiffness parameters and material parameters for 

diagram elements 

Click the button  – Element stiffness and materials. In the 

Stiffness and Materials dialog box (Fig. 159), create a list of Stiffness 

types. On the Stiffness tab, click the Add button, select the second tab – 

Metal Cross-Sections Database, and activate the Pipe cross-section. The 

Steel Section dialog box (Fig. 160) will open, in which you select a product 

from the list, for example, Seamless Hot-Rolled Pipe and Pipe Profile. 
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a)                                           b) 

Fig. 159 – Dialog boxes: a – Stiffnesses and materials (Stiffnesses 
tab), b – Add stiffness 

 

 
Fig. 160 – Steel Section dialog box 
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As for the profile, for the upper chord of the truss, which will be under 

compression, it is worth choosing a slightly stronger one, for example, 

180x12; for the lower chord of the truss, which will be under tension, a less 

powerful one, 168x12; for the lattice elements, an even smaller one, 89x6. 

The profile is chosen arbitrarily, based on the designer's experience or 

intuition. Later, the program will perform a check and selection of truss 

elements. 

For convenience, you can change the color and specify the name of 

the group of elements in the Comment field for each type of stiffness, for 

example, Upper chord. The result will be a list of rigidities (Fig. 161), each 

of which will need to be assigned to the corresponding truss elements. 

However, to design a truss, you need to specify materials and additional 

characteristics. This must be done separately for each type of rigidity. 

 

 
 

Fig. 161 – Created list of stiffnesses 

 

To do this, in the Stiffnesses and Materials dialog box, on the 

Stiffnesses tab, double-click on the 1. Pipe ribbon.  Upper belt, go to the 
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Steel tab, with the Material radio button selected (Fig. 162), click the Add 

button.   

 
 

Fig. 162 – Dialog boxes: a – Stiffness and materials (Steel-Material 

tab), b – Parameters 

 

In the Parameters dialog box (Fig. 162, b), select the steel grade 

from the list and click OK. 

Next, with the Additional characteristics radio button selected (Fig. 

163), specify the type of element – truss, limit flexibility, etc. 

These steps must be performed sequentially for all types of 

stiffnesses from the list. Next, assign the appropriate stiffnesses to all truss 

elements, then close the Stiffnesses and Materials dialog box. 

 



 

123 

 

 

 
Fig. 163 – Dialog boxes: a – Stiffness and materials (Assing properties),  

b – Parameters 
 

Load assignment 

 
Node loads are assigned to the truss. Activate the command button   

– Node Marking, mark the nodes according to the loads: 
 Load 1 – permanent, from the dead weight of the roof 

structures, applied to the nodes of the upper chord of the 
truss, P = 5 kN. 

 Load 2 – short-term, snow, for the entire span, applied to 
the nodes of the upper chord of the truss, P = 4 kN. 

 Load 3 – short-term, snow, for half the span, applied to the 
nodes of the upper chord of the truss, P = 4 kN. 

Each load is formed separately. Twice less load is applied to the 
extreme nodes, because the load area here is twice smaller (Fig. 
164).
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Fig. 164 – Loading 1 

 
The second load is set in the same way (Fig. 165). 

 
Fig. 165 – Loading 2 

 
The third load is applied to half of the truss span (Fig. 
166).

 
Fig. 166 – Loading 3 

 

Generating the DCF table 
 
Since several loads of different durations were specified, it is 

necessary to create an DCF table for further selection of truss member 
cross-sections based on the most dangerous combinations of forces.  

The dialog box of the same name is called by clicking on the button   

– DCF table (DCF panel on the Calculation tab) – Fig. 167. 
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Fig. 167 – Design combinations of forces (DCF) dialog box 
 
In this window, for the selected building codes DBN V.1.2-2:2006, 

you need to specify the types of loads: 1 – permanent, 2 and 3 – short-term 
snow. 

For loads 2 and 3, enter 1 in the text field No. of mutually exclusive 
loads group in order to take into account only the most unfavorable snow 
load for a specific combination of forces. Save the table by clicking the  

button . 
 

Complete calculation of the truss 
 
Before starting the calculation, you need to save the task. To 

calculate, click on the button  – Perform calculation. 

 

Complete calculation of the truss 

Before starting the calculation, you need to save the task. To 

calculate, click the button  – Perform calculation. 
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Viewing and analyzing the results of static calculation 

On the Analysis tab, in the calculation results viewing mode, the 
calculation diagram is displayed by default, taking into account the 
displacements of the nodes. To display the diagram without taking into 

account node displacements, click the button  – Initial Diagram 

(Deformations panel on the Analysis tab).  

Displaying internal force diagrams 

To display the longitudinal force diagram in the truss elements, click 

the button  – Longitudinal force diagrams N (Forces in bars panel on 

the Results tab).  

Fig. 168 shows the diagram of longitudinal forces in truss members 
from the first load. 

 
Fig. 168 – Diagram of longitudinal forces in truss elements from the first 

Loading 

 

Creating and viewing calculation result tables 
 
To display a table with the values of calculated forces in the 

elements of the diagram, click the button   – Documentation 

(Tables panel on the Analysis tab), select the Interactive Tables 

command from the Documentation drop-down list.  

The Form Editor dialog box will appear, in which select the DCF 

bars ribbon (see Fig. 120), in the Create DCF Table window, select the 
desired option – for all elements or only for selected ones (in which case 
these elements must be selected in advance). Confirm the operation. 

The program will generate a table of calculated force combinations 
for the truss elements. 
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Review and analysis of the results of checking and selecting 

steel truss member cross-sections 
 
Go to the Design tab. On the Steel: Calculation panel, activate the 

Calculation command by clicking the  button . The Steel Calculation 
dialog box (Fig. 169) will appear, in which you need to click the Calculate 
button. 

 

 
Fig. 169 – Steel Calculation dialog box 

 

After the calculation is performed, the Max Results by Elements 
panel (Fig. 170) becomes available, which is used to analyze the specified 
cross-sections. 

 

 
Fig. 170 – Max Results by Elements: Inspection and Selection 

By clicking on the button , you will get a mosaic of the 
calculation results for the truss elements according to the first group of 
limit states (for strength) – Fig. 171. At the same time, using the color 
scale, you can determine the percentage of the load-bearing capacity of 
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each truss element for the specified stiffness. 
 

 
 

Fig. 171 – Mosaic of results of strength calculation of truss 
elements 

 

By clicking on the button , you can obtain a mosaic of truss 
member calculation results for the second group of limit states (for 
flexibility). Local stability of members can be checked by clicking on the 

button . The results of cross-section selection are analyzed using the 

corresponding buttons  . The selection of truss elements is 

carried out by pressing a button . 
To view the results of the verification and selection of truss 

elements in tabular form, execute the command Documentation – Results 

tables for steel  in the Tables panel (Fig. 172).  
 
 
 
 
 
 
 
Fig. 172 – Documentation 

command – Results tables for 
steel 
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The Tables dialog box will appear, in which select the Metal Elements tab. 

Check (Fig. 173) and confirm the operation. 
 

 
 

Fig. 173 –Tables dialog box 
 

The program will generate a table (Fig. 174) with the percentages of 

load-bearing capacity exhaustion of steel truss element cross-sections. 

To generate a table with selected cross-sections (Fig. 175), select 

the Steel Elements. Selection ribbon. 
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Fig. 174 – Table for checking specified cross-sections 

 
 

Fig. 175 – Cross-section selection table 

 



 

131 

 

 

Questions for self-assessment 
 
1. What is the purpose of the LIRA-CAD software? 

2. Describe the capabilities of the LIRA-CAD software. 

3. Name the main design systems of LIRA-CAD. 

4. What is a diagram feature? Why is it important to choose it 

correctly? 

5. What operations can be performed on the Design tab? 

6. What reinforcement selection algorithms are implemented in 

LIRA when designing bar elements? 

7.    How to set up units of measurement in LIRA-CAD? 

8.    What loads should be calculated for buildings and structures? 

9.    What is the sequence for creating a calculation scheme? 

10.    What are the features of specifying calculation combinations 

of forces in LIRA-CAD? 

11.    How to generate tables of static calculation results? 

12.    How to assign material parameters for structural calculation? 

13.    How to design a frame transom? A column? 

14.    How to display reinforcement diagrams/mosaics of bar 

elements on the calculation scheme? 

15.     How to display the areas of longitudinal and transverse 

reinforcement for plate elements on the calculation diagram? 

16.    How to display the percentage of reinforcement of cross-

sections and the width of crack openings on the calculation 

diagram? 

17.    How to generate tables of reinforcement selection results in 

the elements of the calculation diagram? 

18.    How to specify rigid inserts when creating a calculation 

diagram for a monolithic beam floor? 

19.    How to call the local reinforcement mode? 

20. How to view and analyze the results of selecting steel truss 

element cross-sections? 
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Content module 2. Calculation and design of structures of multi-

story monolithic frame buildings in the MONOMACH-CAD 

 

Topic 7. Familiarization with the software complex, its 

capabilities and interface 

 

Laboratory Work No. 13 

Purpose and composition of the MONOMAX-CAD software 

package 

 
Purpose and plan of the session 

 

To familiarize students with the purpose of the MONOMAH-CAD 

software package and the programs included in it. 

 

The MONOMAH software package is a typical representative of 

intelligent design systems. The package is designed for calculating and 

designing monolithic multi-story frame buildings. It also calculates brick 

buildings up to 14 stories high with monolithic reinforced concrete elements.  

The MONOMAH PC consists of nine information-linked programs, 

each of which can operate in standalone mode: KOMPONOVKA, BEAM, 

COLUMN, FOUNDATION, RETENTION WALL, SLAB, SECTION (WALL), 

BRICK, SOIL. Figure 1 shows the components of the MONOMAX-CAD 

software package. 

 
 

Fig. 1. Components of the MONOMAH-CAD software package 
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KOMPONOVKA – a root program for designing multi-story frame 
buildings made of monolithic reinforced concrete and buildings with brick 
walls. It allows you to quickly and conveniently create a building diagram in 
interactive graphic mode, set loads in their natural form, calculate the 
strength of building structural elements, select element cross-sections, 
determine the consumption of concrete, reinforcement, bricks, and other 
materials, estimate the cost of construction, and export data to other local 
programs. 
Main functions of the program: 

•    creating a building model on an arbitrary grid plan with columns, 
beams, walls, partitions, floor slabs, foundation slabs, and piles; 
•    calculating brick buildings with load-bearing walls and combined 
frame buildings of increased height with brick infill; 
•    reducing the time required to create a model and perform variant 
design using various service capabilities - moving and rotating the 
coordinate system, copying, transferring, deleting one or a group of 
elements, modifying numerical values, copying floors; 
•    specifying vertical and horizontal loads on floor slabs in the form of 
distributed loads over the entire plane or on a section, as well as in the 
form of concentrated forces; 
•    specifying the direction of impact and information about the 
construction area to take into account wind and seismic loads; 
• importing a soil model created by the GRUNT program; 
•    automatic generation of a building calculation scheme; performing 
static and dynamic calculations to determine displacement, force, and 
stress; selecting or checking element cross-sections; generating a list 
of material costs, frequency tables, and vibration periods. Animation of 
natural vibrations allows you to evaluate the accuracy of the created 
model; 

• еxporting data to the BALKA, KOLONA, FUNDAMENT, PLITA, 
ROZRIS (STINA), TSEGLA design programs, exporting loads on 
foundations to FOK-PC, and exporting the calculation scheme to PC LIRA. 

 
BALKA is a program for designing monolithic reinforced concrete 

beams. The program allows you to design multi-span monolithic beams with 
variable cross-sections. The diagram is generated in import mode and in 
offline mode. Calculations are performed for groups I and II of limit states 
(based on crack opening). It is possible to construct an envelope diagram 
and find the required cross-sectional area of reinforcement. A diagram of 
materials is constructed. The beam is designed using welded frames or 
knitted reinforcement. Drawings are generated and a dxf file of the drawing 
is created. 

COLUMN – a program for designing monolithic reinforced concrete 
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columns of various cross-sectional shapes and pylons. The diagram is 
formed in offline mode and import mode. Calculations are performed for 
groups I and II of limit states with reinforcement selection and design.  

RETAINING WALL – a program for designing and checking retaining 
walls. The program allows you to design a monolithic reinforced concrete 
corner retaining wall for the specified engineering and geological conditions 
of the construction site. A massive retaining wall is checked. The required 
reinforcement area is determined and the design is also performed. The 
diagram is generated in offline mode. A drawing is made and a dxf file of 

the drawing is created. 
FUNDAMENT – a program for designing monolithic columnar 

reinforced concrete foundations on a natural basis. The program allows you 
to design a foundation for a column, calculate the necessary reinforcement, 
and perform the design. A drawing is made and a dxf file of the drawing is 
created. 

SLAB – a program for designing monolithic reinforced concrete floor 
slabs and foundation slabs. The operation of the slab in the general frame 
is implemented by transferring displacements at the junction nodes. Based 
on the calculation results, stress fields and diagrams are constructed for a 
given segment. The stress fields under the base of the foundation slab and 
the force mosaic in the piles are also constructed. 

SECTION (WALL) – a program for designing reinforced concrete 
monolithic and brick walls. The program allows you to design monolithic 
reinforced concrete walls of any shape in conjunction with adjacent frame 
structures. Variable wall thickness and the presence of openings are taken 
into account. The wall's role in the overall frame is taken into account by 
transferring displacements at the CE joints. Based on the calculation 
results, force fields and diagrams for bar elements are constructed. The 
cross-sectional area of the required reinforcement is determined, and the 
wall is reinforced with meshes and bars. 

BRICK is a program for designing walls of brick buildings. During the 
calculation process, the required number of meshes and the selection of 
vertical reinforcement bars are determined. The diagram is generated in 
import mode from the KOMPONOVKA program. 

 

 

Topic 8. Creating a model and calculating a multi-story 

monolithic frame building in the KOMPONOVKA program 

 

Task. Create a model of a multi-story public building according to an 
individual task, perform a static calculation. Perform a detailed analysis of 
the calculation of the main structural elements. 
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Design guidelines 
We will create the building's calculation scheme in the 

KOMPONOVKA program. This is the core program for designing multi-story 
frame buildings made of monolithic reinforced concrete and buildings with 
brick walls. It allows you to quickly and conveniently create a building layout 
in interactive graphic mode, set loads in their natural form, calculate the 
strength of structural elements, select element cross-sections, determine 
the consumption of concrete, reinforcement, bricks, and other materials, 
estimate the cost of construction, and export data to other local programs. 

At the first stage of work, the main characteristics of the building are 
specified (planning mark, soil characteristics, materials of structural 
elements). After that, a typical floor plan is constructed, columns (pylons), 
walls, partitions, existing openings, loads on floor slabs and roofs are 
specified.   

The shape of the building in the plan can be arbitrary. To form a 
spatial planning scheme in height, use the floor copying function with 
subsequent adjustment of the scheme on any floor. The structural scheme 
of a building with load-bearing brick walls can include concrete and 
reinforced concrete walls, columns, beams, i.e., create a combined frame 
with brick filling. 

To correctly collect loads from the dead weight of structures, the user 
must assign the appropriate material from the list of materials to them. 

A detailed description of the process of constructing a calculation 
diagram is given below. You can also use the MONOMAX-CAD electronic 
training manual. 

 

Input data for creating a calculation model in the 

KOMPONOVKA program 
 
The input data for designing a building in the KOMPONOVKA 

program are: 
•    floor plans (basement, first floor, typical floor), 
• sections (with elevation marks),  
•    information about the structural design of the building, main load-

bearing elements (location on the plan, cross-sections, and materials),  
•    dimensions of window and door openings,  
•    permanent and variable loads on floors and roofs, 
• construction area (to determine wind and snow loads),  
•    geological conditions of the construction site. 
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Load collection 

The loads acting on floors and roofs are constant and variable. 

Constant characteristic loads include the weight of the floor or roof. The 

value of the characteristic temporary load is calculated by multiplying the 

thickness of a given layer of material by its volume mass (density). The 

dead weight of a monolithic reinforced concrete floor slab (roof) is 

automatically taken into account by the program when modeling the 

calculation scheme, so there is no need to specify it again. The design 

values of loads are calculated by multiplying the standard values by the 

reliability factors for load action   and by the responsibility class of the 

structure  . The calculation is summarized in tables. 

The characteristic and quasi-constant values of uniformly distributed 

variable (temporary) loads on floor slabs (depending on the purpose of the 

premises) are given in Table 6 of Appendix A (or in Table 6.2 [14]). 

The characteristic values of loads and effects (wind and snow loads) 

for cities in Ukraine are given in Table 11 of Appendix A (or in Appendix E 

[14]). 

 

Table 1. Total load per 1 m2 of floor slab 

№ 
 

 
Load name 

Characteri
stic load, 

kPa 

coefficients Design 
load, kPa 

fm

 

n 

 Permanent load     

1 Ceramic tiles on cement-sand 
mortar,  

 = 0,015 м, m = 1900 кг/м3 

0,285 1,1 0,95 0,298 

2 Cement-sand screed,  

 = 0,02 м, m = 1800 кг/м3 

0,360 1,2 0,95 0,410 

3 Insulation  

 = 0,05м, m = 90 кг/м3 

0,045 1,3 0,95 0,056 

4 Cement-sand screed,  

 = 0,02 м, m = 1800 кг/м3 

0,360 1,2 0,95 0,410 

5 Reinforced concrete floor slab,  

 = 0,16 м, m = 2500 кг/м3 

Load is automatically taken into account 
by the program 

Total: 1,05   1,174 

 Variable load, including: 1,50   1,710 

quasi-permanent 0,35 1,2 0,95 0,399 

short-term 1,15 1,2 0,95 1,311 

 Full load 2,55   2,884 
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Table 2. Total load per 1 m2 of coverage 

№ 
 

 
Load name 

Characte
ristic 

load, kPa 

coefficients Design 
load, kPa f n 

 Permanent load     

1 Rolled carpet,  

 = 0,015 м, m = 600 кг/м3 

0,120 1,1 0,95 0,125 

2 Cement-sand mortar screed 
M100, reinforced with mesh 
150×150 діам. 4 Вр-І,  

 = 0,04 м, m = 1800 кг/м3 

0,720 1,2 0,95 0,821 

3 Insulation - slabs mineral wool, 

 = 0,25 м, m = 100 кг/м3 

0,250 1,3 0,95 0,185 

4 Vapor barrier film 0,014 1,2 0,95 0,016 

5 Cement-sand screed,  

 = 0,02 м, m = 1800 кг/м3 

0,360 1,2 0,95 0,410 

6 Reinforced concrete floor slab 
coverage, 

 = 0,16 м, m = 2500 кг/м3 

Load is automatically taken into account 
by the program 

Total: 1,464   1,557 

 Variable load     

snow 1,240 1,14 0,95 1,414 

 Full load 2,704   2,971 

 

Table 3. Collection of loads from external walls 
№ 
 

 
Load name 

Characteri
stic load, 

kPa 

coefficients Design 
load, kPa f n 

 Permanent load     

1 Lime-sand mortar,  

 = 0,02 м, m = 1600 кг/м3 

0,320 1,2 0,95 0,365 

2 Lightweight concrete blocks,  

 = 0,2 м, m = 400 кг/м3 

0,800 1,2 0,95 0,912 

3 Insulation – slabs mineral wool, 

 = 0,05 м, m = 90 кг/м3 

0,045 1,3 0,95 0,056 

4 Brickwork made of ceramic 
hollow bricks on cement-sand 
mortar  

 = 0,12 м, m = 1200 кг/м3 

1,440 1,2 0,95 1,642 

Total: 2,605   2,975 

 
The load on 1 m of the floor slab from the wall is determined 

depending on the height of the floor (for example, 3 m): 
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- constant characteristic                2,605 3 7 ,815   kN/m;       

- constant design                          2,975 3 8,925   kN/m.       

 

 

Laboratory Work No. 14 

 

Creating a calculation model of a building 
 

Purpose and plan of the session 

 
Create a new task and assign general characteristics to the building. 

Assign materials to the elements of the calculation scheme. Set the 
coordinate axis grid for the projected building. Arrange vertical structural 
elements—columns, pylons, and walls—on the plan. Model openings in the 
walls. 

 

Creating a new task and assigning general building 

characteristics 
 
To start working with the MONOMAH software package's LAYOUT 

program, run the Start – Programs – Monomakh-SAPR – 1. 

KOMPONOVKA command. The program will automatically create a new 
document, so no additional actions are required to create a new project. 

 

To set general data about the building, use the Scheme - Building 

Characteristics menu to open the General Building Characteristics 
dialog box, where you can set: 

 the layout elevation (ground elevation); 
 the top of the column elevation (basement floor elevation); 
 the base elevation (foundation depth); 
 soil characteristics – specified (characteristics of the bearing 

layer – soil bulk weight, internal friction angle, adhesion, 
deformation modulus, Poisson's ratio). Attention! Be careful 
with the units of measurement for these values; 

 the rest of the parameters can be left at their default values 
(Fig. 2).  

 
To save the data, click the OK button. 
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Fig. 2 – General parameters of strukture dialog box 

 

The name of the object is specified using the File - Object Name 
menu. The name may include the student's surname and the name of the 
object. 

 

Assigning material characteristics to building structural 

elements 
 

Using the Scheme - Materials menu, open the Materials dialog box, 
in which you can specify the characteristics of materials for all structural 
elements (Figs. 4, 5). If the assignment specifies the main load-bearing 
elements of the building made of monolithic reinforced concrete, you can 
specify them as follows: 

 
 foundations - concrete class C12/15, working reinforcement - class 

A400C, structural - class A240C; 
 columns (pylons) - concrete class C16/20 - C20/25 (depending on 

the number of storeys of the building), working reinforcement - 
class A400C, structural - class A240C; 

 floor slabs (coverings) - concrete class C20/25, working 
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reinforcement - class A400C, A500C structural - class A240C. 

 
 

Fig. 4 – Materials dialog box 
 
If the building is designed as a frame, then external non-load-bearing 

or self-supporting walls can be left unmodeled, and the load from them can 
be specified as a linear load on the floor at the point where the walls rest 
(along the contour of the floor slab). 

If the building is designed with an incomplete frame or frameless at 
all, with brick load-bearing walls, then the wall material is specified as 
follows: 

 in the Materials dialog box (Fig. 4), click the Add button; 

 in the Type field (Fig. 5), select “Masonry”, specify the brick 
and mortar grades, price per m3 in the appropriate fields, 
and click the “Calculate modulus of elasticity” button. 

To save the data, click the OK button. 
 

Setting the construction grid and coordination axes of the 

building 

 

Open the Cartesian Grid dialog box (Fig. 6) using the Scheme - 

Grid - Add Cartesian Grid Fragment menu, set the axis spacing in the X 
and Y directions in accordance with the floor plan of the designed building. 
Click OK. 
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Fig. 5 – Dialog box for specifying brickwork for walls 
 

 
 

Fig. 6 – Cartesian Grid dialog box 
 
Set the position of the coordination axes of the building using the 

Scheme - Add elements - Add axis menu (button  on the toolbar). In 

the Add axis dialog box, set the name of axis 1 (by default - a1), click the 
mouse button on two grid nodes so that the specified points determine the 
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position of the coordination axis. Consistently, 

setting the required axis names in the Add axis 
dialog box, specify the positions of axes 2, 3, 4, 
etc. according to the building plan. 

 
To display the created axes on the screen, 

you can use the button   to call the 

Visualization toolbar (Fig. 7) and click the button 

. 
 

 
 
 
 
 
 
 
 
 

Fig. 7 – Visualization toolbar 

  

 

 

Creating and placing columns on the plan 

 
Set the parameters and position of the 

columns using the Scheme - Add elements - Add 

column menu (button  on the toolbar). In the 
Add column dialog box (Fig. 8), set the following 
parameters: 

 material - select the one intended for 
the column from the list of materials; 

 cross-section - rectangle (or other); 
 fill in the fields related to the cross-

section dimensions (to make sure that 
the dimensions are set correctly, click 

the button  to display them). 
 
Fig. 8 – Add Column dialog box 
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To place a column on the plan, select the single selection cursor using the 

Scheme – Element Selection – Single Mark Cursor menu (button  
on the toolbar). Indicate on the scheme the node at the intersection of the 
axes according to the building plan. 
You only need to click the mouse once - otherwise you will place several 
columns in one place, which will lead to errors when running the scheme for 
calculation. 
 

Saving model information 
To save model information, select the File – Save menu item (button 

on the toolbar). 
 

Creating and placing walls (pylons) on the plan 
 

Pylons (short walls) can be modeled as columns with a rectangular section 
or as short walls (up to 3 meters long). Set the parameters and position of 

the pylon using the Scheme - Add elements - Add 

wall menu (button  on the toolbar). In the Add 
wall dialog box (Fig. 9), set the following 
parameters: 

 material – select from the list of 
materials the one intended for the wall (pylon); 

 thickness b; 
 support conditions, etc. 
 

Indicate in pairs on the diagram the nodes at the 
intersection of the axes where the walls (pylons) are 
located, according to the building plan. If you need 
to specify an additional node for modeling a short 
wall that is not located at the intersection of the 

axes, you can use the button  — Specify node 

coordinates. 
 

In the dialog box (Fig. 10), specify the node 

coordinates (the Absolute option is selected by 

default); click the Apply button . 

 
Fig. 9 – Add Wall dialog box 
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Fig. 10 – Dialog box for specifying the coordinates of one node 
 
If it is necessary to specify two additional nodes (for example, if the 

wall is offset relative to the axis), you can use the button  — Specify 

coordinates of two nodes (Fig. 11). 
 

 
 

Fig. 11 – Dialog box for specifying the coordinates of two nodes 

 

Modeling openings in walls 

 

To model openings in walls (partitions), you should first add as many 

standard sizes of windows and doors to the Openings Database as the 

project requires. To do this, use the Tools menu - Openings Database. In 

the Openings Database dialog box (Fig. 12), perform the following actions: 

 

 click the Rectangular button — the Opening dialog box will open (Fig. 

13), in which you can specify the window (door) parameters; 

 click the OK button — the specified opening will be added to the end 

  in the opening list group; 

 click on the name of the specified opening in the list ribbon (by default 

Contur1) — its contour will be displayed in the viewing window; 

 click on the name of the specified opening again and change the name 

of the opening to D1 (or B1) – depending on whether it is a door or a 

window. It is worth entering the dimensions of the given opening here, 

so that later it will be easier to navigate in the opening database. 
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Fig. 12 – Hole Database dialog box 

 

To specify a hole in the wall, use the menu Scheme — Adjustment 

— Hole in wall (partition) (button  on the toolbar). After activating this 
mode, specify the wall in the scheme. 

 
 



 

146 

 

 

 
 

Fig. 13 – Opening dialog box 
 

In the Wall Holes dialog box (Fig. 14), perform the following actions: 

 in the Add group, click the From database button — the Add hole 

from database dialog box will open; 
 select the desired hole from the list and specify the coordinates of 

the hole insertion point in the wall; 
 click the OK button — the specified hole will be added to the wall 

drawing in the Wall Holes dialog box; 
 click the OK button. 
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Fig. 14 – Wall Holes dialog box 

 
 
In the same way, specify all the 

openings on the building plan. 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 15 – Add Hole from Base 
dialog box 
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Laboratory Work No. 15 

 

Modeling of floor slabs 

 
Purpose and plan of the session 

 
Define the contour of the slab. Adjust the contour by specifying new 

nodes. Model the holes in the slab. Specify the loads. Specify the reliability 
and duration coefficients of the loads. 

 

Specifying the floor slab contour 

 
Specify the parameters and contour of 

the floor slab using the Scheme - Add 

Elements - Add Slab menu. 
 
 
In the Add Slab dialog box (Fig. 16), set the 
following parameters: 

 material – select the one intended for 
the floor slab from the list of materials; 

 slab thickness b; 
 load on the slab (permanent, short-

term, quasi-permanent). 
Please note that the load evenly distributed 
over the entire slab is set as a slab parameter. 
The slab’s own weight is generated 
automatically by the program, so it does not 
need to be taken into account in the 
permanent load.         
    
 

 
Fig. 16 – Add Slab Dialog Box 
 
Specify the contour of the floor slab – sequentially indicate the 

intersection points of the axes on the diagram according to the building 
plan. 

If you need to specify a node that is outside the grid nodes, then in 

the Add Slab dialog box, click the button  — Specify node 

coordinates. In the dialog box (Fig. 10), select the desired option (absolute 
or relative) and specify the node coordinates. 
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Click the button  — Apply. 
 
 

Adjusting the floor slab contour – adding new nodes and 

moving existing ones 
 
You can change the floor slab contour (for example, add a balcony 

ledge) using the Scheme menu — Adjustment — Move or add contour 

node (button  on the toolbar). To make it easier to specify the 
coordinates of additional nodes, move the origin of the coordinate system to 
the node closest to the desired one at the intersection of the axes using the 

Scheme menu — Coordinate system — Move (button  on the 
toolbar). 

 

Modeling openings in the slab 

 

Openings in the slab are defined using the menu Scheme — Add 

elements — Add opening in the slab (button  on the toolbar). Specify 
the opening nodes on the diagram according to the building plan. 

If there are not enough nodes to model the hole, use the button — 

Specify node coordinates (far left in the Add Hole dialog box (Fig. 17). 
 

 
 

Fig. 17 – Add Hole Dialog Box 
 

A rectangular hole can be defined by coordinates using the button  — 

Define Rectangular Hole (far right in the Add Hole dialog box). In the 
window that opens, define the coordinate of the first node and the X, Y 
increment (Fig. 18). 
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Fig. 18 – Dialog box for specifying the coordinates of the nodes of a 
rectangular opening 

 

Specifying loads on slabs 

 
Considering the self-weight of elements 
 
The self-weight of elements as an external load does not need to be 

specified – it is automatically taken into account based on the specified 
volumetric mass of materials. The load from the self-weight of elements is 
included in the constant load. 

 
Modeling of load stamps 
 
When modeling the floor slab, a uniformly distributed load on it was 

already specified. At the same time, the constant load included the weight 
of the floor, the variable short-term load from people, and the variable long-
term (quasi-permanent) load from furniture, equipment, etc. The variable 
load was taken into account according to the purpose of the building (see 
Table 6 of Appendix A). If there are premises for different purposes on one 
floor of the designed building (for example, offices, assembly halls, 

archives, etc.), then it is necessary to take into 
account the difference in loads, specifying it for 
specific premises in the form of a load stamp. 

 
Make sure you have selected the 

required loading – short-term or long-term 
(quasi-permanent) – by clicking the or button 

,  on the toolbar, respectively. 
The load stamp is set using the menu 

Scheme – Add elements – Add load stamp 

(button  on the toolbar). 
 
Fig. 19 – Add Load Stamp Dialog Box 
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In the Add Load Stamp dialog box (Fig. 19), you need to enter the 
difference between the collected load on the given area and the load 
already applied to the floor slab. 

The load on balconies and loggias can also be specified as a stamp 
or linear evenly distributed over a 0.8 m wide area along the fence. 

 

Linear Load Modeling 
The load from external non-load-bearing or self-supporting walls can 

be specified as a linear load on the floor slab at the point of support of the 
walls - along the contour of the slab (Fig. 20). 

 

 
Fig. 20 – Linear load on the floor from external walls 

 
A linearly distributed load is specified using the 

Scheme – Add elements – Add linear load menu 

(button  on the toolbar). 

In the Add linear load dialog box (Fig. 21), you 
need to specify its value (running load!). 
 
Attention! First, make sure that the selected one is 
required for the duration of the load! 
 

 
 
 

Fig. 21 – Add Line Load dialog box 
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Specifying reliability and duration coefficients 

 
Loads according to DBN V.1.2-2:2006 [4] in the MONOMAKH PC are 

recommended to be specified as follows: 
• to apply operational values of loads to the calculation scheme; 

• in the dialog box Wind according to DBN, specify the reliability 

coefficient according to the operational value 210 ,fe   (so that 

operational values of wind loads are applied to the scheme); 

• in the Coefficients dialog box, called by the Loads - Load 

coefficients command, specify reliability coefficients as the ratio of 
coefficients according to the limit value to coefficients according to the 

operational value ( fefm /   ) of loads. 

Thus, operational loads according to DBN correspond to the 
normative ones according to SNiP, and the limit loads according to DBN 
correspond to the calculated ones according to SNiP. 

With this approach, in the design programs of the PC MONOMAKH, 
limit loads are used to calculate the strength of reinforcement, and 
operational loads are used to calculate the crack resistance of structures. 

Recommended values of load coefficients are given in the 

Coefficients dialog box (Fig. 22). 

 

 
 

Fig. 22 – Coefficients dialog box 
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Laboratory Work No. 16 

 

Calculation and adjustment of floors 

 
Purpose and plan of the session 

 
Perform a floor calculation. Perform floor copying. Change the height 

of floors. Perform floor adjustments. 

 

Floor calculation 
The KOMPONOVKA program provides for the execution of two types 

of calculations - preliminary (simplified) and MSE calculation. The purpose 
of the preliminary calculation is to identify the structural scheme of the 
building, collect loads, check or select cross-sections of structural elements. 
The preliminary calculation consists of a series of calculations and is 

performed using the Calculation - Calculation of the current floor and 

Calculation - Calculation of the entire building menus. 
 
During the calculation, the program performs diagnostics of the 

created model, displays the detected errors in a dialog box. If you select a 
ribbon in the list of errors, the element that caused the error will be 
highlighted in red on the diagram. If several floors have the same 
configuration and load, then create one floor, perform its calculation using 

the Calculation - Calculation of the current floor menu, and then copy it 
to other floors. In this case, both the floor scheme and the calculation 
results are automatically copied. This significantly reduces the time for 
calculating the building. 

So, to check the created scheme, perform the floor calculation using 

the Calculation – Current floor calculation menu (button  on the 
toolbar). 

 
The calculation results are shown in Fig. 23. 
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Fig. 23 – Results of preliminary calculation of a typical floor in 3D 
 

Copying a floor 

 
To form a spatial-planning scheme along the height of the building, 

use the function of copying floors (Floor - Copy floor) with subsequent 
adjustment of the scheme on the first (basement) and last (technical) floors. 
If the planning scheme of other floors differs significantly from the typical 
one, it is advisable to make adjustments on these floors as well. 

Copy a typical floor using the menu Floors - Copy floor (button  

on the toolbar). In the dialog box Copy current floor (Fig. 24), specify the 
data from which floor to copy. After that, click on the OK button. Now the 
specified model will consist of 13 identical floors 

 
 

 
 
 
 
 

Fig. 24 – Copy Over dialog 
box 
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Changing the floor height 
 
To call the desired floor, click on the corresponding selection button 

on the toolbar. 

The floor height can be changed using the Floors — Floor 

Properties menu. In the Current Floor Properties dialog box (Fig. 25), 
you can change the floor name and set a different height. 

 

 
 
Fig. 25 – Floor Characteristics dialog box 
 

Floor Adjustment 
 
Perform floor adjustments according to your task. For example, on 

the first (basement) floor, the load-bearing walls may have different 
parameters (thickness, material), may be located slightly differently, etc. On 
the last (technical) floor, it is worth removing all partitions and linear loads 
from the walls, openings in the slab for the staircase, etc. 

Attention! The load on the floor slab will be slightly different than on 
the floor slabs (see the load collection tables). 

To make adjustments, click on the button with the number of the 

desired floor, for example, . In our case, this is the last floor of the 
building. To remove all partitions and line loads from the external walls, use 

the menu Scheme — Select elements — Select elements by criteria 

(button  on the toolbar).  
In the Select elements by criteria dialog box (Fig. 26), perform the 

following actions: 

 click on the  — Partitions tab; 
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 click the  — Apply button; 

 click on the  — Linear loads tab; 
 select the — Selection action from the list so that the 

sequential selection of partitions is not canceled; 

 click the  — Apply button. 
 

 
 

Fig. 26 – Select elements by criteria dialog box 
 

Close the Select Elements by Criteria dialog box. Delete the 

selected elements using the Diagram — Delete Elements menu (button 

 on the toolbar). 
 
To delete holes, load stamps, or other elements on the floor, use the 

Diagram — Element Selection — Select Elements menu (button   on 
the toolbar). After activating this mode, select these elements on the 

diagram and delete them using the Diagram — Delete Elements menu 

(button  on the toolbar). 
 

If you need to change the load on the slab, use the menu Scheme — 

Adjustment — Element Properties (button  on the toolbar). 
 

To copy and move elements, use the menu Scheme — Adjustment 

— Copy and Move (button  on the toolbar) – Fig. 27. 
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Fig. 27 – Copy and Move dialog box 
 

 
Laboratory Work No. 17 

 

Modeling of Foundation Slabs 

 
Purpose and plan of the session 

 
To model foundation slabs, view the 3D model of the building, and 

adjust the design scheme. 

 

Modeling Foundation Slabs 

 

Make the first floor active by clicking on the floor selection buttons  

and   on the toolbar. 
 
Set the parameters and contour of the foundation slab using the 

menu Scheme - Add elements - Add foundation slab (button  on the 
toolbar) 
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In the Add foundation slab dialog box (Fig. 
28), set the following parameters: 

 overhang – 0.5 m; 
 material – select the one intended 

for the foundation slab from the list of 
materials; 

 slab thickness b (minimum 
recommended thickness – 0.6 m); 

 load on the slab (constant, short-
term, quasi-constant). 

 
      Define the contour of the foundation slab - 
consistently indicate the intersection points of the 
axes on the diagram according to the building 
plan. 
 
 
 
 
 
Fig. 28 – Add Base Slab dialog box 

 

 
 

Viewing the 3D view of the model 

 
View the 3D view of the created model (Fig. 

29) using the View menu - 3D View - Entire Building (button  on the 
toolbar). 
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Fig. 29 – Three-dimensional image of the designed building 

(perspective) 
 

 Switch the axonometric image to perspective using the View 

— Projection — Perspective menu (button  on the 
toolbar). 

 Move the model image down by pressing the PageUp key 
several times. 

 Zoom out by pressing the v key several times. 
 Rotate the model image around its vertical axis by pressing 

the   or  buttons on the toolbar. 

 Return to the main view using the View — Main View menu 

(button  on the toolbar). 

 
 



 

160 

 

 

Laboratory Work No. 18 

 

Performing calculations of the entire building. 

Creating a calculation note and exporting to design programs 

 
Purpose and plan of the session 

 
Perform a preliminary calculation of the entire building. Display the 

specified loads and the results of the floor calculation. Perform the final 
calculation using the finite element method (FEM calculation). 

Generate and prepare for printing a calculation explanatory note 
based on the FEM calculation results. Export data to the design programs 
of the MONOMAKH-SAPR PC. 

 

Calculation of the entire building 
 
Perform a preliminary calculation of the entire building using the 

Calculation – Calculation of the entire building menu (button  on the 
toolbar). 

 
You can view the calculation results in a three-dimensional image 

(Fig. 33) using the View – 3D View – Entire building menu (button  on 
the toolbar). Enable the display of the specified loads and calculation results 

using the View – Display menu. In the Display dialog box, perform the 
following actions: 

 on the active tab  — Elements, check the box for the 
Load option; 

 click on the tab  — Load results; 

 check the box for the Floor calculation results option; 

 click the button  — Apply. 
 

This can be done by clicking the — Loads and — Floor 

calculation results buttons (Visualization toolbar), and then the  — 
Redraw button. 
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Fig. 33 – Three-dimensional image of the designed building with the 
results of the preliminary calculation 

 

You can return to the main view using the View — Main view menu 

(button  on the toolbar). 
 
You can view the calculation results of each floor by clicking on the 

floor selection buttons . 

The calculation results are saved using the File — Save menu. 
 
The calculation and explanatory note is generated based on the 

results of the preliminary calculation of the entire building using the Results 

— Calculation Note — Calculation Note (rtf file) menu. In the Calculation 
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Note dialog box, select the elements of the diagram whose calculation data 
you want to view or print. 

 

FEM calculation 
 
FEM calculation (by finite element method) is mandatory, and the 

final results are accepted according to it. The calculation is performed using 

the Calculation — FEM calculation menu (button  on the toolbar). To 
do this, a finite element scheme is automatically generated taking into 

account the specified parameters in the FEM calculation dialog box (Fig. 
34). For the upper floors of a multi-storey building, the triangulation step of 
slabs and walls is taken as enlarged (3 m each), and for the lower three 
floors, where greater calculation accuracy is required, it is 1.5 m each. To 

do this, in the FEM calculation dialog box, using the Set unique floors 
button, the dialog box of the same name is called (Fig. 35). 

 

The calculation task is started by clicking the button  in the 

MSE calculation dialog box (Fig. 34). 
The calculation processor window will display the calculation scheme, 

the main characteristics of the scheme, and the calculation protocol during 
the calculation. 

After calculating the MSE, the expert system checks the sections of 
reinforced concrete elements for the forces obtained. The detected 
violations are displayed in a dialog box (this concerns the reinforcement of 
sections). 

The results of the MSE calculation are viewed using the View menu 

— MSE calculation results (Fig. 36). The deformed scheme is displayed 

on the screen using the Results menu — Deformed scheme. 

Displacements are analyzed using the Results menu — Displacement 

isofields, stresses – using the Results menu — Stress and force 

isofields. To view information about a specific element or node of the 

scheme, use the Results menu — Information about element or node 

(button  on the toolbar), point to the element or node and get the 
necessary information. 
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Fig. 34 – MFE Calculation dialog box 
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Fig. 35 – Unique floors of the calculation scheme dialog box 

 

 
 

Fig. 36 – Results of MFE calculation 
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Formation of an explanatory note 
A calculation note based on the results of the MSE calculation is 

formed using the Results menu — Calculation note — Calculation note 
(rtf file). 

In the Calculation note of the results of the MSE calculation 
dialog box, in the Output data field, select the options: building 
characteristics, materials, load coefficients. In the Material consumption 
field, select the options: by floors and total. 

In the Calculation results field, specify which elements' calculation 
results should be printed (for a multi-story building, these may be the most 
loaded elements of floors 1-3), otherwise the explanatory note will be very 
voluminous. 

 

 
Fig. 37 – Dialog box Calculation note of MFE calculation results 

 
The explanatory note is created. To save it, execute the Save As 

command. By default, the file will be saved in the Notes directory of the 
MONOMAKH PC. 

Export to design programs of the MONOMAKH PC 

Export the results of the MFE calculation to the MONOMAKH PC 
design programs using the Results menu — Export to the MONOMAKH-
SAPR PC design program (button on the toolbar). A directory with the name 
of your task will be created on the disk in the Port directory of the 
MONOMAKH PC. Files with data on the structural elements of the building 
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will be placed in this directory (Fig. 38). 

 
Рис. 38 – Export to design programs MONOMAKH-SAPR dialog box 

 

 

Questions for self-control 

 

1. What is the MONOMAKH PC intended for? 

2. What programs are included in the MONOMAKH PC? 

3. What initial data is required to create a calculation model in the 

LAYOUT program? 

4. Describe the main stages of building a calculation scheme. 

5. The results of which building calculation are final? 

6. What commands can be used to display the results of a static 

calculation on the screen - displacements, isofields of stresses and forces? 

7. How to view information about a specific element or node of a 

calculation scheme? 

8. How is an explanatory note formed based on the results of a static 

calculation? 

9. How is the calculation results exported to element design 

programs? 

10. Give an algorithm for creating a building model by importing data 

from a dxf file from the AutoCAD program. 
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TOPIC 9. Calculation and Design of a monolithic floor slab in the 

SLAB program in import mode from the KOMPONOVKA program 

 

Task. Using import, obtain a floor slab model in the SLAB program, 

using the building model created in the KOMPONOVKA program; perform 

calculation and design of the slab. 

 

Laboratory Work No. 19 

 

Creating a new problem in import mode 

 

Purpose and plan of the session 
 

Import the file with the slab from the KOMPONOVKA program. 

Calculate the model in the SLAB program. 

 

Import of the slab calculation scheme 

Work with the SLAB program is started by the command Start – 

LIRA-SAPR – Monomakh-SAPR – 6. Slab. 

To import files created in the KOMPONOVKA program, select the 

File – Import menu item (button  on the toolbar), open the desired file 

from the saved folder in the Port PC MONOMAKH directory (slabs are 

numbered with two digits, the first of which means the floor number, the 

second – the slab number). 
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Fig. 40 – Slab No. 2_1 (formwork drawing) 

 

 
 

Fig. 41 – Slab No. 2_1 with loads 
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To check the import of loads, select the menu item Load – 

Permanent (button  on the toolbar). 
 
It is important to remember that the element “partition” in the SLAB 

program is interpreted as a linear load. For floor slabs, vertical loads of 
permanent, long-term and short-term loads are imported. To take into 

account the self-weight of the slab when calculating it, the option Load – 

Taking into account the self-weight of the slab must be set (button  
on the toolbar), and when taking into account the self-weight of the beams, 

the option Load – Taking into account the self-weight of the beams 

(button  on the toolbar). 

Information about the model must be saved (File – Save). 
The slab model is ready for calculation, but it is worth specifying 

some of the parameters accepted by default. In the Materials dialog box, 
on both tabs, you need to check all the data, specify the type of support of 
the slab on columns and walls. Hinged support of the slab on columns and 
walls is accepted by default. You can adjust the support both selectively and 
for all elements at the same time. 

 

Slab calculation 

 

Slab calculation is performed using the Calculation — Calculation 

menu (button  on the toolbar). During the calculation process, the SLAB 
program automatically generates a finite element calculation scheme taking 
into account the specified triangulation step. Static calculation is performed 
by the calculation processor using the finite element method (FEM). 

 

Saving calculation results and exporting to the LIRA PC 

When saving the model using the File — Save menu, the calculation 
results are also saved in the *.plt file. 

If further work with the scheme in the LIRA PC is planned, export the 

calculation scheme using the File — Export to the LIRA PC menu. 
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Laboratory lesson 20 

 

Analysis of the results of calculation and design of the slab 

 
Purpose and lesson plan 

 
In the calculation results display mode, view and analyze the results 

of the calculation and design of the slab. Set the reinforcement color scale. 
Create a calculation note. 

Perform the design of the slab according to the reinforcement 
mosaics: main reinforcement, control of residual reinforcement. Prepare 
slab drawings and specifications. 

 

Viewing calculation results 

 

The calculation results display mode is selected using the Results – 

Results display modes menu. To display displacements and forces, it is 
advisable to select the Isofield+Isolines option, and to display reinforcement 

– Mosaic. 

You can view the displacement isofields using the Results – 

Displacements menu (button  on the Visualization toolbar). 

Displacement isofields are constructed as envelopes. When viewing 

displacements, their calculated values are given. 

To display the moment isofields Mx (Mu) on the screen (Fig. 42), 

execute the command: Results – Forces – Moments Mx (Mu) (button 

 or  on the toolbar). Force isofields are constructed based on loads. 

By default, when viewing forces, their calculated limit values are given. 

Operational (normative) force values can be viewed by clicking the button 

 on the Visualization toolbar. 

 

In the SLAB program, the reinforcement of the slab is considered 

separately - near the upper and lower faces of the slab. Transverse 

reinforcement and reinforcement calculated for compression are 

considered separately. Isofields and mosaics of the calculated 

reinforcement of the slab are constructed separately for the X and Y 

directions. 
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Fig. 42 – Isofields of moments Mx, Mu 
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To display the reinforcement near the top edge of the slab, execute 

the command: Results – Top reinforcement (button  on the toolbar). 
The mosaic of the calculated reinforcement Ax (Fig. 43) is viewed 

using the menu Results – Results display modes – Isofields along the X 

axis (button   on the toolbar). 
 
 

 
 

Fig. 43 – Mosaic of reinforcement Ax near the upper face of the slab 
 

The mosaics help to identify in the SE diagram the slabs with the 
maximum calculated value of the design reinforcement. 

The transverse reinforcement is displayed after selecting the type of 

reinforcement using the Results - Transverse reinforcement menu. To 
display the transverse compression reinforcement, a special compression 
calculation must be performed. 

 

Setting the color scale of reinforcement 

 
When setting the color scale of the design reinforcement, you can 

specify ranges not only in numerical form, but also in analytical form. In this 
case, the value is specified as a formula. For example, the formula s200d10 
means the diameter of the reinforcing bar d = 10 mm with a step of s = 200 
mm and corresponds to a reinforcement area of 3.925 cm2. The formula 
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5d10 (or k5d10) means 5 bars with a diameter of d = 10 mm per 1 linear 
meter and corresponds to a reinforcement area of 3.925 cm2. You can 
specify an expression of the form s200d8 + s200d22 or a mixed expression 
of the form s200d8 + 19.01, where 19.01 is the area value, cm2. 
 

If it is necessary to change the scale parameters, open the Scale 

Parameters dialog box using the Results – Scale Parameters menu 

(button  on the toolbar) and make the necessary changes. As a result, 
the isofields will be displayed according to the new scale parameters. 

This presentation of reinforcement isofields is most often used in real 
design, because it corresponds to the common principle of slab 
reinforcement: along the entire slab near the lower and upper edges of the 
slab, bars of the main reinforcement are inserted, and in places where 
reinforcement is required, bars of additional reinforcement are inserted. 

It is necessary to carefully analyze the location and dimensions of the 
range on the diagram that does not have a formula description, and if 
necessary, make corrections to the range table. For example, you can 
increase the diameter of the additional reinforcement layer or reduce the 
reinforcement pitch. 

 

Generating and reviewing a settlement note 
 

Create a settlement note using the 
menu Results – Settlement note – 
Save html file (button on the toolbar). 
You can also save the explanatory 
note as an rtf file (button ). In the 
Settlement note parameters dialog 
box, check the appropriate boxes 
(Fig. 44). 
 
 
 
 
 
 
 
 
Fig. 44 – Payment Note Settings 
dialog box 
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Slab design 

 
Slab design is performed according to reinforcement mosaics. For 

the specified layout zones, the pitch and diameter of the longitudinal 
reinforcement bars near the upper and lower edges of the slab are 
selected. The residual reinforcement is monitored. The residual 
reinforcement area is determined for each SE of the slab as the difference 
between the calculated value of the reinforcement area and the value of the 
reinforcement area provided by the grids or bars specified in the layout 
areas. For a slab with a cross-sectional height of 160 mm, transverse 
reinforcement is not used, therefore, design with transverse reinforcement 
is not performed. 

 

Layout of main reinforcement bars in a given area 
Main reinforcement with bars is performed on the entire contour of 

the slab using the Design menu – Mesh and bar layout – Rectangular 

contour (button  on the toolbar). In the Reinforcement zone 

assignment dialog box, select the diameter of the reinforcement bars that 
are laid out orthogonally to and along the baseline from the list, and click 

the On the entire contour button. 
The orientation of the bars in the layout area is determined by the 

baseline — the longitudinal bars will be laid out perpendicular to this line, 
and the transverse bars will be laid out along this line. When laying out the 
bars, it can be specified arbitrarily relative to the position of the area. The 
baseline is displayed in blue on the diagram. 

Similarly, the reinforcement area for the second layer is assigned. 
 

Residual reinforcement control 

 
Residual reinforcement is displayed when viewing the reinforcement 

area Ax, Ay in graphical or numerical form for the selected reinforcement 
type - near the upper or lower face of the slab. To do this, execute the 

command Results - Reinforcement display modes - Residual 

reinforcement (button  on the toolbar). 
 

Layout of additional reinforcement bars in specified areas  

 
Assign a section for the bar layout (additional reinforcement) using 

the Design menu - Mesh and bar layout - Rectangular contour (button 

 on the toolbar). 
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In the Reinforcement Zone Assignment dialog box, perform the 
following actions: 

• select from the list the diameter of the bars that will be laid out 
orthogonally to the baseline - 0 mm; 

• select from the list the diameter of the bars that will be laid out along 
the baseline - 0 mm; 

• leave the rest of the parameters by default. 
If only the bar pitch is specified, the selection of the required diameter 

will be performed based on the required residual reinforcement area. 
Viewing the parameters of the assigned layout areas is performed 

using the Design menu — Adjust layout area (button  on the toolbar). 

Deleting assigned layout areas is performed using the Design menu — 

Delete layout area (button  on the toolbar). 

Displaying assigned layout areas is performed using the Design 

menu — Show layout areas of main meshes and bars (button  on 

the toolbar) and Show layout areas of additional meshes and bars 

(button  on the toolbar). 
 

Saving design results 

When saving a model using the File - Save menu (button   on the 
toolbar), the design data is also saved in the *.plt file. 

 

Slab drawing 

 
Slab drawing when reinforced with individual bars is performed using 

the Results — Drawing — Bar drawing menu (button  on the toolbar). 
The SLAB DRAWING program will be launched (in the bar 

reinforcement version). 
 
A drawing consists of separate fragments: grid and bar layout 

diagrams, specifications, main inscription, etc. A certain area is allocated for 
each fragment on the drawing sheet. The scale of the fragment image, with 
the exception of fragments with tables or texts, is determined by the 
dimensions of this area. You can change the sizes of fragment areas, 
move, delete and add new fragments from the existing list of fragments. 
You can also change the sheet format, color and dimensions of individual 
drawing elements (for example, the height of symbols), change the position 
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of footnotes, etc. 
 

Main reinforcement bar layout scheme 

 
By default, a sheet with the main reinforcement bar layout scheme 

near the bottom edge of the slab opens (the  and  buttons on the 
toolbar are pressed). 

 

Drawing correction 
 

The drawing correction mode is entered using the Tools menu — 

Drawing correction (button  on the toolbar). The positions of the bars 

are corrected using the Tools menu — Reposition reinforcement image 

(button   on the toolbar); the positions of the callout lines are corrected 

using the Tools menu — Reposition callout segment (button  on the 
toolbar). 

 

Specification parameters 

 
Since the main reinforcement bars have a length exceeding the 

maximum bar length of 12 m, the specification in the Name column 
indicates the linear length of the bars for each item. The linear length of the 
bars is given taking into account the bar allowance (the total length of the 

bars is multiplied by the allowance coefficient). The Weight per unit column 
indicates the weight of 1 m of a linear bar. 

In order to hide information in the specification and in the steel 
consumption information about bars that are not currently displayed on the 

drawing (additional reinforcement), you need to cancel the Full 

specification table command using the View — Full specification table 

menu (button  on the toolbar). 
You can familiarize yourself with the specification parameters using 

the Service — Specification parameters menu (button  on the 
toolbar). 

 

Filling in the main text 

You can fill in the main text using the Sheet - Main Text menu 

(button  on the toolbar). 
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Printing a drawing 
To print, you need to select a different style for setting colors and 

sizes of drawing elements than the on-screen style using the Tools menu 

— Select colors and sizes — For printing (button  on the toolbar). 
You can change the styles for setting colors and sizes of drawing 

elements using the Tools menu — Colors and sizes (button  on the 
toolbar). 

You can print drawings using the File menu — Print. 

 

Saving the drawing 

To save the corrected drawing, select the File — Save menu item 

(button  on the toolbar). 
 

Importing a dxf drawing file 
If you need to further refine the drawing, you need to create a dxf 

drawing import file. 
To do this, select a different style for setting the colors and sizes of 

the drawing elements using the Tools — Select color and size settings — 

For dxf file menu (button  on the toolbar). 

 

Check whether the zoom mode is enabled in the Fragment — Scale 

fragments for dxf file menu (button  on the toolbar). 

Check the scales of the fragments using the Fragment — Scale 

fragments for dxf file menu. 

Save the dxf drawing file using the File — Save drawing as dxf file 

menu (button  on the toolbar). 
 

Additional reinforcement bar layout scheme 

 
You can restore the original style of setting colors and sizes of 

drawing elements using the Tools menu - Select color and size settings - 

For screen (button  on the toolbar). 
Attention: specifications are given for all reinforcement. To display 

only additional reinforcement, use the View — Full specification table 

command (button  on the toolbar). 
On a new sheet, perform the commands necessary to obtain a high-

quality drawing – adjust the position of the footnotes, set the specification 
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parameters, fill in the main inscription. 
 

 

Questions for self-control 

 
1. How to start working in the SLAB program? 

2. How to import the necessary file with the results of the slab calculation 

from the KOMPONOVKA program? 

3. How is the slab calculation performed? 

4. How to view the results of the static calculation of the slab? 

5. How to view the results of the selected slab reinforcement? 

6. How to set the color scale of the calculated reinforcement? 

7. How to create an explanatory note? 

8. How to design the slab? 

9. How to check the residual reinforcement? 

10. How to lay out the main and additional reinforcement? 

11. How can I correct the drawing? 

 

 

TOPIC 10. Design of columns and pylons in the COLUMN 

program 

 

Laboratory lesson 21 

 

Model creation and column calculation 

 
Purpose and plan of the session 

Create a column model in the COLUMN program, perform its 
calculation. Change design parameters. Export data on releases. Generate 
a calculation note. Prepare a column drawing, add details. 

Creating a new task 

To start working with the COLUMN program, execute the Windows 

commands: Start – Programs – LIRA-SAPR – Monomakh-SAPR – 3. 

Column. 

When launched, the COLUMN program automatically creates a new 
document, so no additional actions are required to create a new task. 

To save information about the model, execute the File – Save menu 
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item (button  on the toolbar). 

 

Data correction 
The new document already contains some data accepted by default. 

Using the Materials – Material characteristics menu, open the 

Column – Material characteristics dialog box, in which you specify the 
concrete class and operating conditions, leaving the remaining parameters 
unchanged. Click the OK button. 
 

Adjust the cross-sectional dimensions and column length using the 

Data – Geometry menu (toolbar button ). 
To make the program take into account the presence of outlets in the 

upper column, select the Data – Column top – Slab and upper section 

menu item (toolbar button ). 

Set the column load using the Data – Loads menu (toolbar button 

). 
 
Important: in the COLUMN program, it is customary to set the 

standard values of loads with a load safety factor, because load safety 

factors are set in a separate table using the Column – Loads menu 

(Coefficients tab). 
 

Column calculation 

 

Column calculation is performed using the Calculation – 

Calculation menu (button  on the toolbar). 
 
In the calculation process, first a calculation scheme is formed and a 

static calculation is performed to determine displacements and forces. After 

that, calculation force combinations are formed, calculation reinforcement is 

determined and the column is designed. 
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Fig. 45 – Calculation and design results 

 

Changing design parameters 

 
If necessary, change the design diameter and assortment using the 

Data – Materials menu (button  on the toolbar). 

In the Column – Material Characteristics dialog box, on the 

Diameters tab, select the design diameter, set the thickness of the 
protective layer; 

on the Requirements tab, specify the design requirements. Perform 

the calculation again (button  on the toolbar) and view the reinforcement 
results. 

 

Exporting Issue Data 

 
Create an export file for the FOUNDATION program using the 

Results – Export Issue Data menu. 

In the Save As dialog box, save the file Column. 

 

Creating a settlement note 

 

Create a settlement note using the Results-Settlement note-Save as rtf 

file menu (button  on the toolbar). 
 

To view the settlement note, execute the Windows command: Start – 

Programs – Microsoft Word. 
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 Open the note using the File –Open menu. 
 In the File type list, select Text in RTF format (*.rtf). 
 Open the desired file. 

 

 

Column drawing 

 

A column drawing is performed using the Results – Drawing menu 

(button  on the toolbar). The COLUMN DRAWING program starts. 

 

 

Adding a list of details 

 

Add a list of details (by default it is not drawn) using the Fragment – 

List of details menu. 
On the diagram, click the mouse in the upper left point of the 

fragment location area and, without releasing the button, set the dimensions 
of the fragment area by moving the cursor to the lower right corner. 

 

 

Laboratory Work No. 22 

 

Import from the KOMPONOVKA program and pylon calculation 
 

Purpose and plan of the session 

Using import, obtain a pylon model in the COLUMN program, using 
the building model created in the KOMPONOVKA program; perform the 
calculation and construction of the pylon. 

Creating a new task 
To start working with the COLUMN program, execute the Windows 

commands: Start – Programs – LIRA-SAPR – Monomakh-SAPR – 3. 

Column. 

To import a file, execute the File - Open menu item (button  on 

the toolbar). Select the required file from the Port folder of the 
MONOMAKH PC. 

The pylon diagram is shown in Fig. 46. The loads on the pylon 
(normative values) are also imported from the KOMPONOVKA program. 
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Fig. 46 – Pylon diagram 
 

To save information about the model, select the File – Save menu 

item (button  on the toolbar). 
 

Data correction 
 
Data adjustments (structural requirements, concrete cover, design 

factors, etc.) in the pylon model are performed in the same way as for 
columns. 

The program allows you to select reinforcement and design pylons 
both according to the classical scheme and according to the arrangement 
of reinforcement along the longer sides of the pylons. 

The Reinforce as pylon characteristic is set using the Data – 

Materials – Requirements menu. 

In the Column – Material Characteristics dialog box, on the 

Diameters tab, select the design diameters, specify the protective layer; on 

the Requirements tab, select the type of transverse reinforcement. 
To take into account the presence of outlets in the upper column or 

pylon, select the menu item Data – Column top – Slab and upper section 

(button  on the toolbar). 
If there is a need to design a pylon or column with two or three floors, 

select the menu item Data – Floors – Add floor from import file. 
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Pylon calculation 
 

The pylon is calculated using the Calculation – Calculation menu 

(button  on the toolbar). During the calculation, the program determines 
the calculated reinforcement and performs the pylon design (Figure 7.3). 

If you check the Reinforce as pylon and Select angle bars options 

in the Data – Materials – Requirements tab menu, you can get another 
design option – with developed angle bars (Figure 47). 

Analysis of the design results, formation of an explanatory note, and 
drawing of a pylon created in import mode are performed in the same way 
as for a column. 
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Рис. 47 – Результати розрахунку та конструювання пілона за класичною 

схемою 
 

 
 
Fig. 48 – Results of calculation and design of a pylon with developed corner 

rods 
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Questions for self-control 

 
1. What is the COLUMN program intended for? 
2. List the main stages of work in the calculation scheme creation mode. 
3. How to specify material characteristics? 
4. How to specify geometric parameters of an element? 
5. How to specify the load on a column? 
6. How to change design parameters? 
7. How to export data on releases? 
8. How to prepare an explanatory note? 
9. How to create a column drawing? 
10. How to add a bill of materials to a column drawing? 
11. List the main stages of creating a pylon calculation scheme in the import 
mode from the KOMPONOVKA program. 
12. How to perform data correction? 
13. How to specify the design diameters of rods, the thickness of the 
protective concrete layer? 
14. How to specify the type of transverse reinforcement? 
15. How to change design parameters? 
16. What command should be executed to take into account the presence 
of outlets in the upper column or pylon? 
17. What command should be executed to design a pylon with two or three 
floors? 
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